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Introduction

Overview

The lllustra 625 PTZ Camera (hereafter referred to as the dome) is a PTZ high definition camera
utilizing the latest in IP technologies. ONVIF-compatibility allows interoperability with other ONVIF-
compliant third party NVRs. A built-in web server allows you to configure the dome and stream

video using Internet Explorer version 8 and higher.

The dome can operate as a standalone camera on a network however it is intended to be
integrated into sophisticated security solutions. The Feature Plus version of the dome features

audio and alarms.

The dome is available in the following configurations:

Illustra 625 PTZ Model Description

Product Codes

lllustra 625 PTZ, 1080p, 20x indoor, no bubble, non-vandal, black

ADCi625-P132

lllustra 625 PTZ, 1080p, 20x indoor, Feature Plus, no bubble, non-
vandal, black

ADCi625-P232

Illustra 625 PTZ, outdoor, Feature Plus, clear, non-vandal, white

ADCi625-P222

Illustra 625 PTZ, outdoor, Feature Plus, clear, vandal, white

ADCi625-P221

Illustra 625 PTZ, outdoor, Feature Plus, smoked, vandal, white

ADCi625-P223

Illustra 625 PTZ, outdoor, Feature Plus, smoked, non-vandal, white

ADCi625-P224

Illustra 625 PTZ, outdoor, smoked, vandal, white

ADCi625-P123

Illustra 625 PTZ, outdoor, smoked, non-vandal, white

ADCIi625-P124

Illustra 625 PTZ, outdoor, clear, vandal, white

ADCi625-P121

Illustra 625 PTZ, outdoor, clear, non-vandal, white

ADCi625-P122
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Installation

This chapter provides detailed instructions on how to install the Illustra 625 PTZ camera. You may
also refer to the printed Quick Install Guide provided with the dome.

Camera Mounts

Refer to the Quick Reference Guide supplied with the mount for installation instructions.

Please refer to the American Dynamics website or contact your American Dynamics Sales
Representative for more information on the various mounts and accessories that can be used with

the lllustra 625 PTZ Camera.

Network Settings

The following provides the default settings for the lllustra 625 PTZ camera and can be used for

reference during installation if required.

Setting Default
Camera Name lllustra625-xxx
DHCP Enabled
IP Address 192.168.1.168
Subnet Mark 255.255.255.0
Default Gateway 0.0.0.0
DNS 0.0.0.0
HTTP Port 80
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Installation

Installation Process

2-4

Remave the dome and make note of the sedal number and MAC
address located on the side of the box or base of the dome.

!

will be used for the configuration and power on.
The dome will begin its initial boot up sequence which will tal
appraximately 1 to 2 minutes.

Ensure that the dome is connected to the computer or netwark which

ke

!

the DHCP Sarver.

The dome will perform three attempts to obtain an IP Address from

DHCP Server found and |P

WO

Address allocated?

A A

The dome will automatically be assigned a
Metwork IP address

Are you using a proprietary

F

The dome will be assigned a Stafic IP
address of 192.168.1.168.

Are you using a proprietary

Metwork Video Recorder (NYR) to
configure the camera?

COpen Microsoft Internet Explorer and enter the
URL of the dome as https:/192.168,1,168,

NOTE: The computer being used to configure
the dome must have an IF address on the
same subnet

MNOTE: illustra Connect can also be used to
discover the dome, Refer to the Corflguration
and User guide for more detailed information.

MNOTE: We recommend that the domes IP
address is changed so that conflicts can be
avolided. However if conflicts do arise, lllustra
Cannect can be used 1o resolve these, Refer
1o the illustra Connect User manual for more
information.

MNetwork Video Recorder (NVR) to YES YES
canfigure the camera?
MO
Using a computer connected to the same
network as the dome, install the illustra
Connact software provided with the camera.
Once Instaled, run the software,
NOTE: The computer being used to discover
the dome must have an IP address on the
same subnal
v
ilustra Connect will automatically detect the
camera, along with all other compatible
devices. (See the illustra Connect User
manual provided with the illustra Connect
software. )
¥ ¥
Locate the dome in the list by it's unique MAC Refer 1o the NVR manual for
address. illustra Connect allows basic information on how to locate
configuration of the camera. Refer to the the dome on the netwark,
illustra Connect User manual for more
information. NOTE: The NVR being usad to
+ configure the dome must have
an |IP address on the same
For more configuration options, right click on subnet.
the camera and select “Launch Web GUI
Configuration” ¢
Selact the
dome.
v
Refer to the Web Configuration chapter in the Canfiguration

» and User guide for details on how to log in to the dome and
maodify the camera's configuration.
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Installation

lllustra Connect

lllustra Connect is American Dynamics camera discovery tool and is supplied with the lllustra 625
PTZ Camera on the CD.

Connecting to IP cameras and configuring them can be a time-consuming and error-prone
process. Typing static IP addresses, or naming cameras without seeing where they are pointed,
often results in longer installations. lllustra Connect eliminates all of these issues with a unique
feature set that includes a one-touch IP conflict resolver and snapshot tool. Simply bring up all of
the cameras out of the box, enter the IP range provided by the customer's IT department and hit
"OK."

Key functions of lllustra Connect are:

» “Resolve All Conflicts” button instantly alerts you to all IP addresses that are the same and
provides a number of options to fix issues

» Greatly reduces installation time by automatically supplying static IP addresses from a
configurable range of IP addresses

» Snapshot views of all of the cameras

» “Save Device List” allows you to create a .csv file of all information regarding the camera
settings

+ Set IP addresses via DHCP

» Configure IP settings and rename cameras

* Upload firmware to individual or a selectable group of cameras

» Set date and time or direct the cameras to a specific NTP server

» Assign user name and password

» Uses icons common to victor unified client to display camera status

* Compatible with American Dynamics IP cameras
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Install and Detect the lllustra 625 PTZ Camera

The following provides detailed information for installing and accessing the dome.

Installation using DHCP and lllustra Connect

The following provides information for installing the dome on your network using the lllustra
Connect discovery tool.

lllustra Connect enables automatic discovery of compliant devices on IP networks and is the
recommended method for installation and detection of the dome on the network.

Note

The lllustra Connect will only discover devices on the same subnet as it's host computer.
Therefore the dome and the computer being used to configure it must be on the same subnet.

Procedure 2-1 Installing the lllustra 625 PTZ Camera using lllustra Connect

Step  Action

1 Using the Quick Start Guide install and connect the dome to the computer or network
which will be used for the configuration and power on.

The dome will begin its initial boot up sequence which will take approximately 1 to 2

minutes.

2 When using a DHCP Server the dome will automatically be assigned a Network IP
address.

3 Using a computer which is connected to the same network and subnet, install the lllustra

Connect software that is provided with the dome. Refer to the lllustra Connect manual for
more information.

4 When the installation is complete, run lllustra Connect. It will search the network and
display all compliant devices, including the dome.

5 Select the dome you wish to configure, locating it by it's unique MAC address. lllustra
Connect allows basic configuration of the dome.

Refer to the lllustra Connect manual for more information.
Right-click the dome and select Launch Web GUI Configuration.

7 Refer to the Web Configuration chapter for details on how to log in to the dome and modify
the configuration.

- End -
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Installing the lllustra 625 PTZ Camera using DHCP Server Logs

Procedure 2-2 Installing the Illustra 625 PTZ Camera using DHCP Server Logs

Step  Action

1 Using the Quick Start Guide install and connect the dome to the computer or network
which will be used for the configuration and power on.

The dome will begin its initial boot up sequence which will take approximately 1 to 2
minutes.

2 When using a DHCP Server the dome will automatically be assigned a Network IP
Address.

3 View the DHCP Server system logs and make note of the IP address assigned to the
dome.

4 Open Microsoft Internet Explorer and enter the URL of the dome as shown in the DHCP
Server log.

Note

The computer being used to configure the dome must have an IP address on the
same subnet.

5 Refer to the Web Configuration chapter for details on how to log in to the dome and
modify the configuration.

- End -

Installation without a DHCP Server using a Static IP Address

The following provides information for installing the dome on your network when no DHCP Server
is available. In this situation the dome will be assigned a Static IP Address.

Note

1 We recommend that once you are logged into the Web Configuration pages you change the
Static IP Address of the dome so that conflicts can be avoided when using the same Static IP
Address to setup additional cameras. Refer to TCP/IP for information on changing the IP
address of the dome.

2 In a situation where IP address conflicts arise, lllustra Connect can be used to discover the
device. Refer to IP Address Conflicts in the lllustra Connect User Guide for further information.

Procedure 2-3 Installing the Illustra 625 PTZ Camera when a DHCP Server is not
available

Step  Action

1 Using the Quick Start Guide install and connect the dome to the computer or network
which will be used for the configuration and power on.
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Installation

The dome will begin its initial boot up sequence which will take approximately 1 to 2
minutes.

The dome will attempt to obtain an IP Address from the DHCP Server. When no DHCP
Server is available the dome will be assigned a Static IP address of 192.168.1.168.

Open Microsoft Internet Explorer and enter the URL of the dome as https://192.168.1.168.

Note

1 The computer being used to configure the dome must have an IP address on
the same subnet.

2 lllustra Connect can also be used to discover the dome when using a Static IP
Address. Refer to Procedure 2-1 Installing the lllustra 625 PTZ using lllustra
Connect and begin at Step 3.

Refer to the Web Configuration chapter for details on how to log in to the dome and modify
the configuration.

- End -
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Web Configuration

This section details how to configure the dome using the built-in Web Configuration feature.
Depending on user access you can view Live video and control the camera through PTZ controls
as well as changing the settings for the camera environment.

Note

1 Adobe Reader must be installed to view the online help.

2 To view the Live Video Pane the latest version of QuickTime must be installed and enabled on
the computer running the browser session.

3 Web Configuration sessions timeout after a period of inactivity.

4 Only users with administrative rights can access all the areas of the Web Configuration pages.
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Web Configuration

Log in and Log Off the Dome

Logging in to the Dome

Use the following procedure to access the dome Web GUI.

Procedure 3-1 Log in to the Dome

Step  Action

1 Refer to the Installation Chapter for details on how to connect the dome to your network or
computer.

2 When the dome is selected the sign in page will be displayed.

Select your preferred language from the drop down menu.
The default language is ‘English’.
4 Enter the username in the Username text box.
Enter the password in the Password text box.
Select Log in.
Depending on the access rights of the user account, there may be specific camera
functions that are unavailable. All camera functions are described in this manual.

Note

The default Username is admin and the default Password is admin. To maintain
security the password on the admin account should be changed. Refer to
Procedure 7-5 Change User Password.

- End -

Logging out of the Dome
Use the following procedure to log off the dome Web GUI.

Procedure 3-2 Log off the Dome

Step  Action

1 Select Log Off in the upper right hand corner of the Web GUI.
You will be logged off the dome and sign in page will be displayed.

- End -
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User Accounts

There are three types of user account that can be used to access the dome:

* administrator

» operator

* user

Refer to Appendix A: User Account Access for detailed information on access areas.

To add a new user refer to Procedure 7-4 Add a User.

Administrator Access

The administrator account provides full access to the dome. This user account has access to all of
the cameras functions and information.

Operator Access

The operator account provides the following access:

* View Menu: Full access to Picture Settings. Presets, Patterns, Privacy Zones and Scans can be
created, edited, viewed, deleted and activated.

* Program Menu: Sequences can be created, edited and viewed.

» Camera Configuration: PTZ, Video, Stored Audio and Home Position can be edited, viewed
and activated.

» Networking: User account password can be changed.

¢ Information: Model information, Statistics, Environmental and Current Faults can be viewed.

User Access

The user account provides the following access:

» View Menu: Presets, Patterns, Privacy Zones and Scans can be viewed and activated.
* Program Menu: Sequences can be viewed and activated.

» Camera Configuration: View audio list and listen to stored audio.

* Networking: User account password can be changed.

« Information: Model information can be viewed.

The Dome Web GUI Interface

When logged into the dome the screen will display the live video feed full screen as seen in Figure
3-1 Live Full Screen View.

Refer to GUI Icons for details on the icons used throughout the Web GUI.
Refer to Configuring the Web Video Stream to edit display settings.
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Figure 3-1 Live Full Screen View

Full Screen Live Video  Setup Menus

Help
American Dynamics _ LoG ofF
From Tyco Security Products ve View |Setun View ”J US‘ rJJa

Eilm > J GUI Camera Controls

I
! |
Start/Stop Video Volume Control

Accessing the Setup Menus from Full Screen Live View

Setup menus within the Web GUI are restricted by user account access levels.

Procedure 3-3 Access Setup Menus from Full Screen Live View

Step  Action

1 When displaying full screen live video select Setup View in the GUI banner to access the
setup menus.

The Information page will be displayed.

- End -

Displaying Full Screen Live Video

Display the live video feed full screen on screen.
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Procedure 3-4 Display Live Video Full Screen

Step  Action

1 Select Live View in the GUI banner.

The live video feed will displayed full screen. Refer to Configuring the Web Video Stream
to edit display settings.

- End -

Overview of the Web GUI

Figure 3-2 The Dome Web GUI provides an overview of the lllustra 625 PTZ Web GUI.

Figure 3-2 The Dome Web GUI

Menus Selected Tab Tabs Live Video Pane
Full Screen Live Video Access Menus

Help
Apmerican Dynarics LOG OFF

Frdm Tyco Security Projucts [_Live view] [Setup view 7|JJ u:r— i:JJa

Presets
Pattems Auto White Balance ]
Privacy Zones

Scans

From Tyco Secunity Froducts

Start/Stop Video  Volume Control
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GUI Icons

The following provides information on the icons used throughout the dome interface. These icons

will be referenced throughout this manual:

Select to start the live video

Select to stop the live video

P pane. pane.
Check box, deselected. Check box, selected.
Volume is active. Use the Volume has been muted.
<)) Volume Control slider bar to -

adjust the volume.

l Pan and tilt quick control ¢ Refresh the current tab.
View or activate the &5 Edit the corresponding function.
® corresponding function.

Delete the corresponding
]I function.

Slider bar - The slider bar can be moved
left or right using the mouse. For fine
adjustments, select the slider bar with the
mouse and use the left and right arrow
keys on the PC keyboard to adjust the
slider.

Select the page number or arrows to
navigate the pages.

<||=[[1[[2|[3]||4]||B]||=||=

Viewing Live Video via the Live Video Pane

The live video pane provides a simple way to view the video inputs from the dome when using the
setup menus. The live viewing page however is not intended to be the primary way of viewing the
video on the dome; this should be performed using the Network Video Recording device.

Viewing Live Video via the Live Video Pane
The Live Video Pane is accessible to any authorized user and is displayed when accessing the

setup menus. It is not displayed on the following pages; Scheduled Tasks, Alarms, Logs and
Current Faults.
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Procedure 3-5 Viewing Live Video via the Live Video Pane

Step  Action
1 Select to start the live web video.

Refer to Configuring the Web Video Stream to edit display settings.
2 Select to stop the live web video.

- End -

Controlling the Dome using Camera Controls

The dome may be controlled using the on-screen controls in the Live Video Pane.

GUI Camera Controls

The following provides information on the controls that are available for the on-screen dome
control. The camera control overlay is visible when video is displayed on the Live Video Pane.

Zoom Pan/Tilt Control

.C]g) of =
88000 E

Iris Zoom Pan/Tilt Movement Focus

B3

Focus

@
B

m— Open m_ n @ m_ Near
@ p @ | © @ Pan/Tilt @

@._ Auto Iris Q D @ (outer rim) % Auto Focus
@_ Close @— Out ©@© \@_ Far

Note

It is possible for two users to access live viewing at the same time however only one user may
control the camera at any time. Camera control operates on a “last come, first served” basis,
therefore when a new user logs into the camera from a different browser and starts a camera
control session the original user will lose their camera control session.
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Controlling the camera via Keyboard Shortcuts

The following keyboard shortcuts can be used to control the dome:

Pan Left Pan Right
«— - 9
T Tilt Up ,l, Tilt Down
+ Zoom In = Zoom Out

Controlling the camera via Camera Controls

The dome may be controlled using the on-screen controls in the Live Video Pane.

Procedure 3-6 Controlling the camera via the Live Video Pane

Step  Action

1 Select to start the live web video.

The live video pane will display the current camera view.

2 Select the camera control item on the overlay to activate the control.

Refer to GUI Camera Controls for information on specific camera controls.

- End -

Controlling the Pan/Tilt Control via Click and Drag

Controlling the dome using the mouse allows for slower camera movement which will provide
maximum accuracy.

3-16
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Procedure 3-7 Controlling Pan/Tilt via Click and Drag using the Live Video

Pane
Step  Action
1 Select to start the live web video feed.

The live video pane will display the current camera view.

Move the cursor to the pan and tilt quick control icon E in the center of the video pane.
Click and drag the cursor to set the direction and speed of the camera.

» A red arrow will appear showing the direction of camera movement.

» The camera’s movement speed increases as the arrow is moved further from
the cursor origin mark.

- End -

Zooming Using the Mouse Scroll Wheel

Control the zoom function using a scroll wheel mouse.

Procedure 3-8 Zooming via the mouse scroll wheel using the Live Video

Pane
Step  Action
1 Select to start the live web video feed.
The live video pane will display the current camera view.
2 Refer to Controlling the camera via Camera Controls or Procedure 3-7 Controlling
Pan/Tilt via Click and Drag using the Live Video Pane to point the camera at the target.
3 Scroll the mouse wheel upwards (zoom in) and downwards (zoom out).
- End -

Double-click to Center using the mouse

Click on the live video pane to automatically center the camera display.

Procedure 3-9 Activate Double-click to Center using the mouse

Step  Action

1 Select to start the live web video feed.
The live video pane will display the current camera view.
2 Using the mouse, double-click on the area of interest in the live video pane.
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3-18

The PTZ will adjust to display the area of interest in the center of the live video pane.

3 Repeat step 2 to select a new area of interest.

- End -

PTZ to a Selected Area using the mouse

Draw a rectangle on the live video pane to have the camera PTZ adjust to the selected area of
interest.

Procedure 3-10 Activate PTZ to a Selected Area using the mouse

Step  Action

1 Select to start the live web video feed.

The live video pane will display the current camera view.

Click and drag on The live video pane to highlight the area to display.
3 A red outline will appear to show the selected area of interest.

Release the mouse button, the PTZ will adjust to display the area of interest in the center
of the live video pane.

4 Repeat step 2 to select a new area of interest.

- End -
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When the view menu is selected Figure 4-1 View Menu will be displayed.

Figure 4-1 View Menu

Help
American Dynamics LOG OFF

From Tyco Security Products Live View  Setup View HJ US i‘JJa

[} Picture Balance Focusflris WDR IR/DayNight Shutter Limit Picture Settings
Presets

Patterns Auto White Balance O]

Privacy Zones

Scans

[0 N e ——— ))

From Tyco Security Products

The View Menu provides access to the following dome settings and functions:
* Picture Settings

* Presets

+ Patterns

* Privacy Zones

« Scans
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White Balance

White balance (the ability to keep whites looking white) is normally compensated for automatically
via the default Auto White Balance (AWB) setting. Manual White Balance (MWB) is available when
specific color temperature settings want to be set and preserved. This can be done using the red

and blue slider adjustments set for optimal viewing.

Configuring White Balance

Adjust the white balance.

Procedure 4-1 Configure Auto White Balance

Step  Action

1 Select Picture Settings from the View menu.
The White Balance tab displays.

2 Select the Auto White Balance check box to enable auto white balance.
Or

Deselect the Auto White Balance check box to disable auto white balance and enable
Manual White Balance. Manual White Balance can be adjusted using the red and blue
sliders. Refer to Procedure 4-2 Configure the Red and Blue Balance.

The default setting is Auto White Balance ‘enabled’.

- End -

Configuring the Red and Blue Balance

Adjust the red and blue balance.

Procedure 4-2 Configure the Red and Blue Balance

Step  Action

1 Select Picture Settings from the View menu.
The White Balance tab displays.
2 Select to start the live web video.
The live video pane will display the current camera view.
3 Deselect the Auto White Balance check box to disable auto white balance.

Note

When Automatic White Balance is first switched from enabled to disabled, the red
and blue values displayed are based on the current feedback values from the
camera.
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4 Use the slider bars to change the Red and Blue balance. The live video pane will update
to display the new settings.

The red and blue values range from 0% to 100%.

- End -

Picture Balance

Adjust brightness, contrast and saturation of the image displayed in the Live Video Pane.

Adjusting Picture Balance

Configure brightness, contrast and saturation.

Procedure 4-3 Adjust the Brightness, Contrast and Saturation

Step  Action

Select Picture Settings from the View menu.

2 Select the Picture Balance tab.

The Picture Balance tab displays.
3 Select to start the live web video.
The live video pane will display the current camera view.
4 Use the slider bars to change:
» Brightness
» Contrast
 Saturation (color level)
The live video pane will update to display the new settings.
The values range from 0% to 100%.
The default values are 50%.

- End -

Restoring Picture Balance

Use this procedure to restore picture balance settings to factory default.

6 American Dynamics 4-21



View Menu

Procedure 4-4 Restore Picture Balance Defaults

Step  Action

Select Picture Settings from the View menu.
2 Select the Picture Balance tab.
The Picture Balance tab displays.
3 Select Defaults to restore the default settings.
The default settings are 50%.

- End -

Focus/Iris

When Auto Focus and Iris are enabled the camera automatically compensates for scene changes
that effect focal length (focus) and light levels (iris).

If Auto Iris and Focus are turned off a feature called ‘Return Settings’ (refer to Procedure 6-3
Enable/Disable Return Settings) can be configured to automatically return Focus and Iris to Auto
modes after the dome is commanded to move a sufficient amount (about half a screen width, and
more than a few seconds).

Note

Auto Focus and Auto Iris can also be adjusted, enabled and disabled using GUI Camera Controls.

Setting Auto Focus

Enable or disable auto focus on the dome.

Procedure 4-5 Enable/Disable Auto Focus

Step  Action

Select Picture Settings from the View menu.

2 Select the Focus/Iris tab.
The Focus/Iris tab displays.

3 Select the Auto Focus check box to enable auto focus.
Or
Deselect the Auto Focus check box to disable auto focus.
The default setting is ‘Enabled’.

- End -
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Setting Auto Iris

Enable or disable auto iris on the dome.

Procedure 4-6 Enable/Disable the Dome Auto Iris

Step  Action

Select Picture Settings from the View menu.
Select the Focus/Iris tab.
The Focus/Iris tab displays.

3 Select the Auto Iris check box to enable auto iris.
Or
Deselect the Auto Iris check box to disable auto iris.

The default setting is ‘Enabled’.

- End -

Wide Dynamic Range

Configuring WDR

Wide Dynamic Range (WDR) is a feature that allows viewing of high contrast scenes that include
both bright and low light areas in the same field of view (FOV).

A typical use for this feature would be viewing a scene with both indoor and outdoor lighting
conditions simultaneously, for example, in a warehouse area with an open bay door.

Procedure 4-7 Disable/Enable Wide Dynamic Range (WDR)

Step  Action

1 Select Picture Settings from the View menu.

The white balance tab displays.

2 Select the WDR tab.
The WDR tab displays.

3 Select the WDR check box to enable WDR.
Or

Deselect the WDR check box to disable WDR.
The default setting is ‘Disabled’.

- End -
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IR/DayNight Mode

4-24

IR/DayNight Mode utilizes a series of specific camera functions to dramatically enhance low light
performance.

When needed one of these functions, the True TDN mechanism, removes an IR Cut Filter (IRCF)
from in front of the imager allowing the camera to see in black and white (BW) and utilize
additional near-infrared energy found in many lighting sources like halogen, moonlight, etc.

This, along with slowing down another function, the shutter speed, significantly improves low light
performance rendering clear images where none could be viewed previously.

IR Mode

When the camera is in B/W mode it can utilize or “see” near-IR illumination; something the human
eye cannot do. This can be extremely powerful when the dome is paired with 850~950nm IR
illuminators. With this combination a scene can be well lit with IR light that the dome can see but
people cannot. This is great for areas where externally lighting is not allowed or there is a need for
covert security.

Normal, or visible light, and IR light have different focal points. The camera has 3 IR modes to help
optimize focus capabilities and achieve sharper IP pictures when using these light sources. Please
refer to Table 4-1 Corresponding IR Switching with IR illumination for recommended settings.

Table 4-1 Corresponding IR Switching with IR illumination

IR Curve For Lighting Sources Visibility
Visible Normal Lighting —, Florescent, Both the dome (in Color and BW) and the
Incandescent, Sunlight, etc human eye can utilize these types of

illumination sources

850nm 850nm IR illuminators Only the dome (in BW) can utilize this
type of illumination source. The human
eye cannot.

950nm 950nm IR illuminators Only the dome (in BW) can utilize this
type of illumination source. The human
eye cannot

Configuring IR

Adjust IR mode on the dome.

Procedure 4-8 Configure IR Mode

Step  Action

Select Picture Settings from the View menu.

2 Select the IR/DayNight Mode tab.
The IR/DayNight Mode tab displays.
3 Select an IR Mode setting:
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* visible - Most common, visible lighting sources.
» 850nm - Ideal for 850nm IR llluminators.

* 950nm - Ideal for 950nm IR llluminators.

The default setting is ‘visible’.

- End -

Day Night Mode

The dome provides a black-and-white (B/W) mode to improve camera performance when the light
level falls below certain thresholds. This allows clear images to be obtained under low-light
conditions. There are five Day/Night settings: Off, On, Auto High, Auto Mid and Auto Low.

Configuring Day Night Mode

Procedure 4-9 Configure Day Night Mode

Step  Action
1 Select Picture Settings from the View menu.
2 Select the IR/DayNight tab.
The IR/DayNight tab displays.
3 Select a Day Night Mode setting:

+ off - disable the Day Night Mode. The camera will operate in color mode only.
* on - enable full-time black and white mode.

+ autolow - stays in color mode the longest only switching to BW at the lowest
light levels.

» automid - good balance of Color and BW mode performance.

+ autohigh - in color mode this is the least switching in and out of black and white
at the highest light levels of the three.

The default setting is ‘autolow’.

- End -

Shutter Limit

In addition to the IR & Day/Night Modes the lllustra i625 PTZ dome provides additional
functionality to help compensate for low-light scenes: Automatic Gain Control (AGC) and Open
Shutter.
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Automatic Gain Control (AGC)

Amplifies the video signal in scenes when there is not enough light to produce full video levels.
The maximum level of AGC is controlled by the Max Gain control. It is adjustable from 0dB (off) to
37dB. As gain is increased, the sensor noise is also amplified which can result in more noticeable
noise in the image.

Open Shutter

This is a technique that is used for really low light performance applications. It allows the shutter
speed to be slowed down further than normal to allow the sensor to collect more light. The
maximum level of Open Shutter is controlled by the Shutter Speed control. It is adjustable from
1/30 down to Y2 second. The slower the Shutter Speed the higher the chance for image blur which
may affect moving object identification. It is only in effect during low light situations where an
image would not be obtainable otherwise and does not affect the camera performance in normal or
bright light situations.

Configuring AGC/Shutter Settings

Adjust Automatic Gain Control and Shutter Settings.

Procedure 4-10 Configure the AGC/Shutter Setting

Step  Action

1 Select Picture Settings from the View menu.
2 Select the Shutter Limit tab.

The Shutter Limit tab displays.
3 Select a AGC/Shutter setting:

* AGC off - produces the cleanest image with the least noise but the worst low
light performance.

* AGC on - good low light performance with the chance for some noise.

» openshutter - best for low light performance. However there is a chance for
some noise and some image blur.

The default setting is ‘openshutter’.

Note

If you require “Real Time” video open shutter must be turned off to ensure that the
resulting video quality is acceptable for prosecution purposes.

- End -
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Shutter Speed

Changing the Shutter Speed
Selecting a fast shutter speed will give the least amount of artifacts but reduced low light

performance, a slower shutter speed will give better low light performance but more artifacts will
be visible.

Procedure 4-11 Configure Shutter Speed

Step  Action

Select Picture Settings from the View menu.
2 Select the Shutter Limit tab.
The Shutter Limit tab displays.

When ‘openshutter’ is selected from the AGC/Shutter setting the Shutter speed section
display.

3 Select a Shutter speed setting from the drop down menu:
« 1/2
«1/4
«1/8
» 1/15
» 1/30
The selection will be applied.
The default setting is ‘1/8’.

- End -

Max Gain
The Max Gain setting is an upper limit for how much gain can be increased when AGC is enabled.
The trade-off between picture level (brightness) and noise may be adjusted by setting the Max

Gain value. Lower values for Max Gain setting may result in a darker picture but with less noise.
Higher values for Max Gain setting may result in a brighter picture but with more noise.

Configuring Max Gain

Adjust max gain settings on the dome.
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Procedure 4-12 Configure Max Gain

Step  Action

Select Picture Settings from the View menu.
2 Select the Shutter Limit tab.
The Shutter Limit tab displays.

When ‘AGC on’ or ‘openshutter’ is selected from the AGC/Shutter Setting the Max gain
section will be displayed.

3 Use the slider bar to change the Max gain setting.
The values range from 1 to 37.
The default setting is 37.

- End -

Picture Settings
The picture options allow you to save the current settings, restore saved settings or restore to

factory default settings.

Saving Picture Settings

Save the current picture settings to the dome.

Note

If the dome is rebooted or powered off, upon restart the picture settings will return to the last saved
settings. If picture settings have not been saved, upon restart the dome will use the default picture
settings.

Procedure 4-13 Save Current Picture Settings

Step  Action
1 Select Picture Settings from the View menu.
2 Select the Picture Settings tab.
The Picture Settings tab displays.
3 Select Save to save and retain the current picture settings.
- End -
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Restoring Saved Picture Settings

Restore previously saved picture settings.

Procedure 4-14 Restore Saved Picture Settings

Step  Action

Select Picture Settings from the View menu.
Select the Picture Settings tab.
The Picture Settings tab displays.
3 Select Restore to restore the previously saved picture settings.

- End -

Restoring Factory Default Picture Settings

Restore the factory default picture settings.

Procedure 4-15 Restore Factory Picture Settings

Step  Action

Select Picture Settings from the View menu.

2 Select the Picture Settings tab.
The Picture Settings tab displays.
3 Select Defaults to restore the factory picture settings.
- End -
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Presets

A Preset is a pre-positioned camera scene that you program for cameras installed with pan/tilt and
motorized lens capability. Up to 96 presets can be programmed for the dome.

Adding a new Preset

Create a new preset position on the dome.

Procedure 4-16 Add a Preset

Step  Action

1 Select Presets from the View menu.
The Preset tab displays.
2 Select to start the live web video.
The live video pane will display the current camera view.
3 Adjust the camera view as required.
 Pan, Tilt and Zoom.
* Focus Mode and Iris Mode.
Refer to GUI Camera Controls to make the required adjustments.

4 The following camera controls can be modified and saved as part of the preset and
accessed via the Picture Settings menu:

» White Balance
* Picture Balance
» Wide Dynamic Range (WDR)
+ IR/DayNight
 Shutter Limit
In a numbered slot on the preset table, select |:| to add the new preset.
Enter the preset name in the Preset Name text box.
7 Select Add to save the preset.
Or
Select Cancel.

- End -

Viewing a Preset

View an existing preset position.
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Procedure 4-17 View a Preset

Step  Action
1 Select Presets from the View menu.
The Preset tab displays.
2 Select to start the live web video.
The live video pane will display the current camera view.
3 Select to activate the corresponding preset.

The live video pane will update to display the selected preset.The preset will display until
interrupted by a camera command, pattern, scan or alarm.

- End -

Editing a Preset

Edit an existing preset position.

Procedure 4-18 Edit an existing Preset

Step  Action
1 Select Presets from the View menu.
The Preset tab displays.
2 Select to start the live web video feed.
The live video pane will display the current camera view.
3 Select to activate the corresponding preset.

The live video pane will update to display the selected preset.
4 Select D to edit the corresponding preset.
Edit the preset name in the Preset Name text box if required.
Adjust the camera view as required.
* Pan, Tilt and Zoom.
* Focus Mode and Iris Mode.
Refer to GUI Camera Controls to make the required adjustments.

7 The following camera controls can be saved as part of the preset and accessed via the
Picture Settings menu:
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» White Balance

* Picture Balance

» Wide Dynamic Range (WDR)
+ IR/DayNight

 Shutter Limit

8 Select Add to save the updated preset.
You will be prompted to confirm the update.
9 Select OK to save the changes.
Or

Select Cancel.

- End -

Deleting a Preset

Delete an existing preset position from the dome.

Procedure 4-19 Delete a Preset

Step  Action

1 Select Presets from the View menu.
The Preset tab displays.
2 Select E to delete the corresponding preset.

You will be prompted to confirm the deletion.

Note

You cannot delete a preset while it is associated with another camera function. To
remove the preset refer to the associated camera function.

3 Select OK to confirm the deletion.
Or
Select Cancel.

- End -
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Patterns

A pattern is a series of pan, tilt, zoom and focus movements which can be saved to the dome. A
maximum of 17 patterns can be programmed for the dome with an unlimited duration.

Note

1 The lllustra 625 PTZ provides Apple Peel, which is a predefined pattern stored on the camera
by default that covers the entire viewing area. This pattern slowly pans 360° starting at the
ceiling line. It then tilts 30° and pans 360° again, repeating until the entire viewing area is
covered. The pattern will repeat continuously until interrupted by a camera command, preset,
scan or alarm.

2 There are two Apple Peel patterns on the dome by default. Apple Peel pattern one is read only
and cannot be edited or deleted. Apple Peel pattern two can be edited and if necessary
deleted from the dome.

Adding a Pattern

Create a new pattern.

Note

A 15 minute time out period is implemented when adding a pattern. If no command is received
within the time out period the Add a Pattern procedure will automatically terminate.

Procedure 4-20 Add a Pattern

Step  Action
1 Select Patterns from the View menu.
2 Select the Record tab.
The Record tab displays.
3 Select to start the live web video feed.

The live video pane will display the current camera view.
4 Enter the pattern name in the Pattern Name text box.
Select Start.
The Record page will update with an Add and Cancel button.
6 Use the GUI Camera Controls to configure the required pattern settings.
The following controls can be saved as part of the pattern:
* Focus
* Iris
7 Select Add to save the pattern.
Or
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Select Cancel.

- End -
Running a Pattern

Activate an existing pattern.
Procedure 4-21 Run a Pattern
Step  Action
1 Select Patterns from the View menu.

The Patterns tab displays.
2 Select to start the live web video feed.

The live video pane will display the current camera view.
3 Select to activate the corresponding pattern.

The live video pane will update to display the selected pattern.The pattern will run
continuously until interrupted by a camera command, pattern, scan or alarm.

- End -
Deleting a Pattern
Delete an existing pattern.
Procedure 4-22 Delete a Pattern
Step  Action
1 Select Pattern from the View menu.
The Patterns tab displays.
2 Select @ to delete the corresponding pattern.

You will be prompted to confirm the deletion.

Note

You cannot delete a pattern while it is associated with another camera function. To
remove the pattern refer to the associated camera function.

3 Select OK to confirm the deletion.
Or

4-34 Configuration and User Guide



View Menu

Select Cancel.

- End -

Repeating a Pattern

Use this procedure to have a pattern repeat until interrupted by a new command.

Procedure 4-23 Enable/Disable Repeat a Pattern

Step  Action

1 Select Pattern from the View menu.
The Patterns tab displays.
Select the Repeat tab.
3 Select the Repeat Pattern check box to allow the pattern to repeat continuously.
Or
Deselect the Repeat Pattern check box to allow pattern to run one time only.

The default setting is ‘Enabled’.

- End -
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Privacy Zones

4-36

Privacy Zones are “masked” sections of the dome’s viewing area. These masks prevent operators
of the surveillance system who do not have access to the dome password from viewing these
designated zones. Each zone has four sides, and the zones may overlap to form irregular shapes.
The Privacy Zones move in relation to the dome pan/tilt position.

In addition, the apparent size of the Privacy Zone adjusts automatically as the zoom level is
adjusted. Privacy Zones are useful for high security areas. For example, you might establish a
privacy Zone around a safe’s combination, but still view people approaching or opening the safe.
When Privacy Zones are active, the dome's firmware automatically disables text transparency.

Up to 32 rectangular privacy zones can be used on the dome.

Note

Areas of the Privacy Zone may be exposed during rapid pan / tilt movements of the dome. To
compensate for this limitation, you may want to program the Privacy Zone to be 20 to 25% larger
than the area you want to mask.

Defining a Privacy Zone

Create a privacy zone on the dome.

Procedure 4-24 Define a Privacy Zone

Step  Action

Select Privacy Zone from the View menu.

2 Select the Add Zone tab.
The Add Zone tab displays.
3 Select to start the live web video feed.

The live video pane will display the current camera view.
4 Adjust the camera view as required.
Refer to GUI Camera Controls to make the necessary adjustments.
Enter the privacy zone name in the Privacy Zone text box.
Select Draw.

The image will freeze and a still image will be displayed. The Add page updates to display
a Add and Cancel button.

7 Using the cursor locate the start point for the privacy zone, click and drag on the still image
to define the privacy zone area. As the cursor is moved a red shape will appear on the
image which highlights the privacy zone.

8 Release the mouse button.
The selected privacy area will turn red.

9 To reselect an alternative area for the privacy zone repeat steps 7 and 8.
10 Select Add to save the current privacy zone.
Or
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Select Cancel.

Note

When a new privacy zone is created it is automatically enabled, refer to
Procedure 4-25 Enable/Disable a Privacy Zone to modify this setting.

- End -

Enabling or Disabling a Privacy Zone

Select a privacy zone to hide or display on the dome.

Procedure 4-25 Enable/Disable a Privacy Zone

Step  Action

1 Select Privacy Zone from the View menu.
The Privacy Zones tab displays.
2 Select to start the live web video feed.
The live video pane will display the current camera view.

3 Select to activate the corresponding privacy zone.

The live video pane will update to display the selected privacy zone.
4 Select the corresponding Enabled check box to enable the privacy zone.
Or

Deselect the corresponding Enabled check box to disable the privacy zone.

- End -

Deleting a Privacy Zone

Delete a privacy zone from the dome.

Procedure 4-26 Delete a Privacy Zone

Step  Action

1 Select Privacy Zone from the View menu.
The Privacy zones tab displays.
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2 Select the corresponding Delete check box to mark the privacy zone for deletion.

Note

More than one privacy zone can be deleted at a time. The Select All check box
can also be used.

3 Select Delete to delete the selected privacy zones.
You will be prompted to confirm the deletion.

4 Select OK to confirm the deletion.
Or
Select Cancel.

- End -
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Scans
A scan allows you to program left and right scan limits to automate surveillance activities. Once
these scan limits are programmed you can choose to run a smooth scan, stepped scan, or random

scan. When active, the scan repeats until interrupted by a camera command, preset, pattern or
alarm.

Setting Scan Limits

Set left and right scan limits on the dome.

Procedure 4-27 Set Scan Limits

Step  Action

Select Scans from the View menu.

2 Select the Scan Limits tab.
The Scans Limits tab displays.

3 Select to start the live web video feed.
The live video pane will display the current camera view.

4 Adjust the camera view as required to locate the left scan limit.
Refer to GUI Camera Controls to make the necessary adjustments.
Select Set Left to set the displayed position as the left limit.

Adjust the camera view as required to locate the right scan limit.
7 Select Set Right to set the displayed position as the right limit.

The scan limits have been set and the selected scan will now run within the scan limits set.

- End -

Set Scan Limits to Default Settings

Return the dome to the default scan settings.

Procedure 4-28 Set Scan Limits to Default Settings

Step  Action
1 Select Scans from the View menu.
2 Select the Scan Limits tab.

The Scans Limits tab displays.
3 Select Defaults.
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The scan limits will default to Left: 0 and Right: 359.

- End -

Activating a Scan

Activate a scan on the dome, this will run using the scan limits saved in Setting Scan Limits.

Procedure 4-29 Activate a Scan

Step

Action

Refer to Setting Scan Limits before activating a scan.
Select Scans from the View menu.

The Scans tab displays.

Select to start the live web video feed.

The live video pane will display the current camera view.
Select to activate the corresponding scan.

* smooth - slowly pans between the left and right scan limits, starting at the left
scan limit. When the right scan limit is reached, the scan reverses

* stepped - pans slowly, pausing briefly every 10° between the left and right scan
limits. Once the right scan limit is reached, the scan reverses.

* random - pans randomly between the left and right scan limits. For example, the
scan may start at 10°, then pan right 40° and pause, pan right 20° and pause,
pan left 30° and pause, and pan right until it reaches the right scan limit.

The live video pane will update to display the selected scan.The scan will run continuously
until interrupted by a camera command, pattern, preset or alarm.

- End -
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When the view menu is selected Figure 5-1 Programs Menu will be displayed.

Figure 5-1 Programs Menu
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From Tyeo Security Products

The Programs Menu provides access to the following dome settings and functions:
» Sequences

* Alarms

» Scheduled Tasks

* Areas
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Sequences
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A Sequence is a sequential display of multiple camera Presets. Sequences provide a methodical
and effective way to monitor multiple areas of interest by switching to different Presets
automatically.

Sequences are created by identifying Preset views to include in the Sequence and specifying a
dwell time that controls how long each Preset remains on-screen before switching to another
Preset.

Up to 16 Sequences can be created, each with 16 steps (Presets).

Adding a Sequence

Create a new sequence on the dome using defined presets. Refer to Adding a new Preset if no
presets have yet been added to the dome.

Procedure 5-1 Add a Sequence

Step  Action

If no presets have been created refer to Adding a new Preset before continuing to step 2.
Select Sequences from the Programs menu.

Select the Add Sequence tab.

The Add Sequence tab displays.

w

Enter the sequence name in the Sequence text box.
Select a preset from the Preset Name drop-down menu.
Enter a dwell time in seconds in the Dwell Time text box.

N o o b~

Select Add. The preset is now listed as part of the sequence.
Or
Select Cancel.

8 Repeat steps 5 to 7 to add further presets to the sequence.

Note

Up to 16 presets can be added to a sequence.

9 Select Apply to save the sequence.

- End -

Activating a Sequence

Activate a selected sequence.
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Procedure 5-2 Activate a Sequence

Step  Action

1 Select Sequences from the Programs menu.

The Sequences tab displays.
2 Select to start the live web video feed.

The live video pane will display the current camera view.
3 Select to activate the corresponding sequence.

The live video pane will update to display the selected sequence.The sequence will run
continuously until interrupted by a camera command, pattern, preset, scan or alarm.

- End -
Editing a Sequence
Edit an existing sequence.
Procedure 5-3 Edit a Sequence
Step  Action
1 Select Sequences from the Programs menu.
The Sequences tab displays.
2 Select D to edit the corresponding sequence.

The sequence will open in the Edit Sequence tab.

Edit the sequence name in the Sequence Name text box if required.
Select D to edit the corresponding preset, the following can be edited:
* Preset Name

To add a new preset to the sequence, move to the next available free slot and select a
preset from the Preset Name drop-down menu.

* Dwell time
If required, select @ to remove the corresponding preset from the sequence.
Select Add to save the changes
Or
Select Cancel.
7 Select Apply to save the changes.

- End -
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Deleting a Sequence

Delete an existing sequence.

Procedure 5-4 Delete a Sequence

Step  Action

1 Select Sequences from the Programs menu.
The Sequences tab displays.

2 Select @ to delete the corresponding sequence.
You will be prompted to confirm the deletion.

3 Select OK to confirm the deletion.
Or

Select Cancel.

- End -
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Alarms

If using a lllustra 625 PTZ Feature Plus camera it will be possible to configure and trigger alarms.
The dome can be commanded to carry out a specified operation when a alarm is triggered.

Note

Scheduled tasks, return to home, alarms and manual camera control will always begin when they
are selected or scheduled to start. None of these camera actions have a priority over the other. If a
camera action is in progress and a new action is selected or activated the previous action will stop
before the new action is started.

The dome provides four alarm inputs. By connecting alarm devices, such as smoke alarms,
twilight sensors, or motion sensors, to these inputs, you can enhance the usability of your video
surveillance system. You can further improve your video surveillance by assigning a action, such
as a preset or pattern, to start whenever an alarm input changes from normal to abnormal.

» For 15 seconds after being triggered any additional individual input changes on that alarm
source will only be logged and not generate any other action. This is to reduce the effect that any
oscillating alarm source, e.g. if a door is simply vibrating in the wind, causing a series of alarms
to be generated.

+ Input alarms are triggered upon change of state. Either from opened to closed or from closed to
open. The camera will report the current state of each input alarms (open or closed) as well as
an active or inactive status in the alarm configuration page. Active alarms will also be visible in
the current faults page.

+ The triggering of any input alarm will affect scheduled tasks and delay them until at least 30
seconds has passed since the last digital alarm input was triggered.

Alarm Actions

Upon triggering each alarm input can be configured to trigger any combination of the following
actions:

» PTZ action: none or a stored preset, pattern, sequence or scan.

* The result of this PTZ action will continue until another PTZ, scheduled task or return home
command is received. A PTZ command from the Web GUI or ONVIF will be responded to
immediately, possibly interrupting the programmed PTZ action. A PTZ action from a different
digital input will also be done immediately. PTZ commands originating from a scheduled task
only interrupt the alarm PTZ action if more than 30 seconds has passed since the triggering.
Otherwise, they get delayed.

+ Activate the digital output contact. This stays active until the alarm is acknowledged and cleared
by an operator.

« Send an external alarm WS-Event that includes alarm details

» Send an external alarm via email that includes alarm detail, where to retrieve the AVI video file
and one JPEG picture of the event if recording MJPEG to local storage. If MJPEG is not being
recorded on local storage, then no JPEG picture will be sent.

» Send an audio file to the dome. If a speaker has been connected to the audio output on the
dome the file can be played as the alarm is triggered.
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» Send an AVI video file to a pre-configured external FTP server. The video file will contain pre and
post alarm video buffer and audio if enabled and supported, as outlined above.

Note

1 An active internal alarm only resets when the input state changes to “normal.” A manual reset
is not available.

2 A microSD Card must be inserted to send an SMTP email, video files, audio and images from
triggered alarms.

Creating an Alarm

Create an alarm on the dome.

Procedure 5-5 Create an Alarm

Step  Action

1 Select Alarm from the Programs menu.
The Alarm Summary tab displays.

2 Select a numbered tab (1-4) to create an alarm.
The alarm input tab displays.
Enter the alarm name in the Name text box.
Select an Action:
* preset
* pattern
* sequence
e scan
* none

If an action is selected choose the type of action to perform from the Action Parameter
drop-down menu.

5 Select the Audio Playback check box to select an audio clip to play when the alarm has
been triggered.

Note

Audio clips can only be used if a microSD card has been installed.

a Select the clip from the Select Clip drop down menu.

6 Select the Email check box to send an e-mail to the user configured in Procedure 7-7
Configure SMTP Settings.
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7 Select the FTP check box to send a video file to the details configured in Procedure 7-9
Configure FTP Server Settings.

Note

1 AVl clips can only be sent via FTP if a microSD card has been installed and FTP has been
selected. If FTP is not selected the AVI clip will be saved to the microSD card and it will have to
be removed from the camera to view the video file. Refer to Removing the MicroSD Card.

2 The selected pre and post event duration buffer will be included in any video clips sent via FTP.

a Select the Data Format by selecting the radio buttons:
*Video(AVI) - a playable movie containing MJPEG video.
*Audio/Video (AVI) - a playable movie containing MJPEG video and
G711 audio.
Refer to Configuring the Web Video Stream to modify the video
settings.
b Select the Pre Event duration in seconds from the drop-down menu. Values range
from 0 to 10.
The default setting is 5 seconds.
The exported video will include
Select the Post Event duration in seconds from the drop-down menu. Values range
from 0 to 10.
The default setting is 5 seconds.

8 Select Apply to save the alarm settings.

- End -

Enabling or Disabling an Alarm

Set an alarm to enable or disable.

Procedure 5-6 Enable/Disable an Alarm

Step  Action

1 Select Alarm from the Programs menu.
The Alarm Summary tab displays.

2 Select the Enabled check box to enable the corresponding alarm.
Or

Deselect the Enabled check box to disable the corresponding alarm.

- End -
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Enable or Disable Alarm Output

Alarm Output allows the alarm to activate a digital output as an action. For example, this digital
output could be linked to an electrical device, i.e. a security light or siren.

Procedure 5-7 Enable/Disable Alarm Output

Step  Action

1 Select Alarm from the Programs menu.
The Alarm Summary tab displays.

2 Select the Output check box to enable alarm output.
Or

Deselect the Output check box to disable alarm output.

-End -
Editing an Alarm
Modify the details of an existing alarm.
Procedure 5-8 Edit an Alarm
Step  Action
1 Select Alarm from the Programs menu.

The Alarm Summary tab displays.

Select the numbered tab (1-4) of the alarm to edit.

Make the necessary adjustments to the alarm settings, the following can be edited:
* Name

* Action

* Action Parameter

* Audio Playback

* Email

* FTP

4 Select Apply to save the alarm settings.

- End -

View Active Alarms

Display a list of active alarms on the dome.
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Step  Action

1 Select Current Faults from the Information menu.

The Current Faults tab displays with a list of current faults found on the dome. Alarms will
be listed under the Component heading of DIOM.

- End -

Clearing Alarm Output Logs

When an alarm is triggered it registers on the dome in the Current Faults table. Clear the alarm
logs from the dome if it has been triggered.

Procedure 5-9 Clear an Alarm

Step  Action

1 Select Current Faults from the Information menu.
The Current Faults tab displays.
2 Select the Alarm Output tab.
The Alarm Output tab displays.
‘Cancel Active Output’ will be displayed. Select Apply to clear active alarms.
The text will update to ‘Output Not Active’.

- End -

MicroSD Card

A MicroSD card can be used with the camera to provide additional functionality when using
alarms. The following provides details of functions available without and when using a MicroSD
card:

Without a MicroSD Card

» Current faults notifications displayed on camera if an alarm is triggered.
Using a MicroSD Card

» Current faults notifications displayed on camera if an alarm is triggered.
+ Video/Audio and screenshot are saved to the MicroSD card.

+ SMTP notifications can be sent.

» FTP uploads of video can be sent.

* Audio can be played via the Audio Out port.
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Inserting the MicroSD Card

When inserting a MicroSD card it is essential that the camera is rebooted. If at any stage you need
to insert a MicroSD card into the camera one of the following two procedures should be used:

* Insert the MicroSD Card by powering down the camera - Use this procedure if you are unable
reboot the camera via the GUI.

* Mount the MicroSD Card via the GUI to reboot the camera - Use this procedure when you are
unable to access the power supply to the camera.

Note

If the lllustra 625 PTZ Camera is being used with the Outdoor Housing Assembly or Indoor
Housing Assembly, refer to the Quick Reference Guide supplied with the product for details on
how to remove the housing assembly and gain access to the camera.

Procedure 5-10 Insert the MicroSD Card by powering down the camera

Step  Action

Turn off the lllustra 625 PTZ Camera by turning off the power supply.
2 Insert the MicroSD card into the camera.
Apply power to the lllustra 625 PTZ Camera.

When the camera is restarted it checks its functionality by performing a homing routine
during which the camera pans and then either goes to the start point of the ‘apple peel’
pattern or if powered up once before, to the last position in memory. Once the camera
stops, it is online and ready to be accessed and controlled.

- End -

Procedure 5-11 Mount the MicroSD Card via the GUI to reboot the camera

Step  Action
1 Insert the MicroSD card into the camera.
2 Refer to Procedure 7-20 Reboot the dome.

- End -

Removing the MicroSD Card

If at any stage you need to remove the MicroSD card from the camera one of the following two
procedures should be used:

* Remove the MicroSD Card by powering down the camera - Use this procedure if you don’t have
access to the web GUI and are unable to un-mount the MicroSD card before removal.

5-50 Configuration and User Guide



Programs Menu

* Unmount the MicroSD Card for Removal - Use this procedure when you are unable to access
the power supply to the camera.

Note

If the lllustra 625 PTZ Camera is being used with the Outdoor Housing Assembly or Indoor
Housing Assembly, refer to the Quick Reference Guide supplied with the product for details on
how to remove the housing assembly and gain access to the camera.

Procedure 5-12 Remove the MicroSD Card by powering down the camera

Step  Action

Turn off the lllustra 625 PTZ Camera by disconnecting the power supply.
2 Remove the MicroSD card from the camera.

Note

AVI clips will not be available on the camera until the MicroSD card has been
inserted and the camera rebooted.

3 Apply power to the lllustra 625 PTZ Camera.

When the camera is restarted it checks its functionality by performing a homing routine
during which the camera pans and then either goes to the start point of the ‘apple peel’
pattern or if powered up once before, to the last position in memory. Once the camera
stops, it is online and ready to be accessed and controlled.

- End -

Procedure 5-13 Unmount the MicroSD Card for Removal

Step  Action

1 Select Alarm from the Programs menu.
The Alarm Summary tab displays.

When a MicroSD card has been inserted the Unmount SD card button will be displayed.
This will only be displayed on the GUI when a MicroSD card is inserted.

2 Select Unmount SD card to prepare the MicroSD card for removal.
You will be prompted to confirm the unmounting.

3 Select OK to confirm.
Or
Select Cancel.
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4 Remove the MicroSD card from the camera.

Note

AVI clips will not be available on the camera until the MicroSD card has been
inserted and the camera rebooted.

- End -
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Scheduled Tasks

Schedule tasks to include specific situations or events; you can set up a regular schedule or a
custom schedule. Schedules could be set for the dome to perform a task, Monday to Friday with a
different task for weekend or holiday operation.

Note

Scheduled tasks, alarms and manual camera control will always begin when they are selected or
scheduled to start. None of these camera actions have a priority over the other. If a camera action
is in progress and a new action is selected or activated the previous action will stop before the new
action is started.

Creating a Scheduled Task

Create a new scheduled task.

Procedure 5-14 Create a Scheduled Task

Step  Action
1 Select Scheduled Tasks from the Programs menu.
2 Select the Add Task tab.

The Add Task tab displays.
Enter a task name in the Name text box.
Select a start time from the Start Time (HH:MM) drop-down menu.
Use 24hr clock.
5 Select the Task Frequency:

« every day
» week days
» days of month

If week days is selected you will be required to choose the days on which days the task
will run. Select the check box beside the day to add that day to the task frequency.

If days of month is selected you will be required to enter the a numerical value for the day
separated by a comma. For example, to run on the 4th, 10th, 21st and 25th days of the
month enter 4,10,21,25.

6 Select the Action:
* preset
* pattern
* sequence
e scan
* none

If an action is selected choose type of action to perform from the Action Parameter drop-
down menu.

7 Select Apply.
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Select the Scheduled Tasks tab to display a list of tasks currently set on the dome.

- End -

Editing a Scheduled Task

Edit the details for an existing scheduled task.

Procedure 5-15 Edit a Scheduled Task

Step  Action

1 Select Scheduled Tasks from the Programs menu.
The Scheduled Tasks tab displays.

2 Select D to edit the corresponding task.
The task will open in the Edit Task tab.

3 Changes can be made to the following:

» Task Name
« Start Time (HH:MM)
» Task Frequency
* Action
4 Select Apply to save the changes.

- End -

Deleting a Scheduled Task

Delete an existing scheduled task.

Procedure 5-16 Delete a Scheduled Task

Step  Action

1 Select Scheduled Tasks from the Programs menu.
The Scheduled Tasks tab displays.

2 Select the corresponding Delete check box to mark the scheduled task for deletion.
Or

Deselect the corresponding Delete check box to keep the scheduled task.

Note

Select the Select All check box to mark all tasks for deletion.
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3 Select Delete to delete the selected scheduled tasks.
You will be prompted to confirm the deletion.

4 Select OK to confirm the deletion.
Or
Select Cancel.

- End -
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Areas
Areas allow sections within the field of view to be labeled. These labels may then be turned on

within the Overlay Settings option. Areas may not overlap. The zoom level affects the size areas
may appear.

You may program up to 16 areas on the dome.

Programming an Area

Set an area on the dome.

Procedure 5-17 Program an Area

Step  Action

1 Select Areas from the Programs menu.
The Areas tab displays.
2 Select to start the live web video feed.
The live video pane will display the current camera view.
In a numbered slot on the areas table, select |:| to add the new area.
Enter the area name in the Name text box.
Adjust the camera view as required to locate the left boundary.
Refer to GUI Camera Controls to make the necessary adjustments.
6 Select Set in the Left column to set the displayed position as the left boundary.

Note

This must not be less than the right boundary of the previous area.

Adjust the camera view as required to locate the right boundary.
8 Select Set in the Right column to set the displayed position as the right boundary.

Note

This must not be greater than the next area’s left boundary.

9 Select Add to save the area.
Or
Select Cancel.

- End -

Editing an Area

Edit the details for an existing area on the dome.
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Procedure 5-18 Editing Areas

Step  Action

1 Select Areas from the Programs menu.
The Areas tab displays.
Select I:I to edit the corresponding area.
Changes can be made to the following:
* Name
* Left boundary
* Right boundary

4 Select Add to save the changes to the area.
Or
Select Cancel.

- End -
Deleting an Area
Delete an existing area from the dome.
Procedure 5-19 Delete an Area
Step  Action
1 Select Areas from the Programs menu.
The Areas tab displays.
2 Select the corresponding Delete check box to mark the area for deletion.

Or

Deselect the corresponding Delete check box to keep the area.

Note
Select the Select All check box to mark all areas for deletion.

3 Select Delete to delete the selected areas.
You will be prompted to confirm the deletion.
4 Select OK to confirm the deletion.
Or
Select Cancel.

- End -
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When the Camera Configuration menu is selected Figure 6-1 Camera Configuration Menu will be

displayed.
Figure 6-1 Camera Configuration Menu
Help
American Dynamics - Loc ol
From Tyco Security Products Lve e sen View JJJ US.EJJE,

& Freeze Frame Retumn Settings. Set North

ic Flip

0sD
Video
Home
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The Camera Configuration Menu provides access to the following dome settings and functions:
» Pan/Tilt/Zoom (PTZ)

+ On Screen Display (OSD)

+ Video

* Audio

* Home
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PTZ

The PTZ function allows you to adjust Automatic Flip, Freeze Frame, Return Settings and Set
North.

Adjusting Automatic Flip

6-60

Use the automatic (proportional) “flip” feature when you need to track someone who walks directly
under the dome and continues on the other side. You start the flip by moving the tilt control to its
lower limit and holding for a brief period. When the flip engages, the dome automatically rotates
180°. You may then continue to track the person as long as the tilt control stays in its lower limit.
Once the tilt control is released, the dome resumes normal operation.

Procedure 6-1 Diable/Enable Automatic Flip

Step  Action

1 Select PTZ from the Camera Configuration menu.
The flip tab displays.

2 Select the Automatic Flip check box to enable automatic flip.
Or
Deselect the Automatic Flip check box to disable automatic flip.

The default setting is ‘disabled’.

- End -

Freeze Frame

If you need to maintain a static image when calling automatic functions, such as presets or
patterns, use the Freeze Frame setting. This prevents the dome movement and lens adjustments
being displayed on-screen while the preset or pattern is being found.

When the Freeze Frame setting is enabled, the scene currently displayed on the video pane will
be preserved (frozen) on-screen until the preset is ready for display. The image then switches
smoothly to the new scene. This may help reduce bandwidth utilization when presets or patterns
are used often.

Procedure 6-2 Disable/Enable Freeze Frame

Step  Action

Select PTZ from the Camera Configuration menu.
2 Select the Freeze Frame tab.
The Freeze Frame tab displays.
3 Select the Freeze Frame check box to enable the freeze frame function.
Or
Deselect the Freeze Frame check box to disable the freeze frame function.
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The default setting is ‘Disabled’.

- End -

Return Settings
When calling a Preset, the dome adopts the settings uniquely created for that Preset. When an

operator moves the dome from its Preset position, the dome can return to global settings only if
programmed to do so through the Return Setting page.

Procedure 6-3 Enable/Disable Return Settings

Step  Action

Select PTZ from the Camera Configuration menu.
2 Select the Return Settings tab.
The Return Settings tab displays.
3 Select the corresponding check box to enable the return settings for:
* Return to Auto Focus
* Return to Auto lIris
* Return to Previous
Or
Deselect the corresponding check box to disable the setting.

The default setting to have all set to ‘Enabled’.

- End -

North Position

Direction Indicators permit you to understand the approximate pointing position of the dome to an
established reference point. This reference point is called “North” and may correspond to magnetic
north (if it is known) or some other landmark or fixture. When the dome is initially installed, “North”
defaults to a pre-defined position (0° pan/tilt). You may program the “North” position to be any point
along the dome’s pan axis.

Procedure 6-4 Set North Position

Step  Action
1 Select PTZ from the Camera Configuration menu.
2 Select the Set North tab.
The Set North tab displays.
3 Select to start the live web video feed.

The live video pane will display the current camera view.

@ American Dynamics 6-61



Camera Configuration Menu

4 Adjust the camera view as required to locate the north position.
Refer to GUI Camera Controls to make the necessary adjustments.

5 Select Set North to save the current view as the north position.

- End -
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On-Screen Display (OSD)

Within OSD you can set the display options for camera name, status, settings names,
time/direction indicators and text attributes.

Displaying the Camera Name

The camera name will be shown on the on-screen display (OSD) if the option is enabled.

Procedure 6-5 Display or Hide the Camera Name

Step  Action

1 Select OSD from the Camera Configuration menu.
The name tab displays.

2 Select the Camera Name check box to display the camera name in the OSD.
Or
Deselect the Camera Name check box to hide the camera name in the OSD.

The default setting is ‘Disabled’.

- End -

Displaying Camera Status
You can choose to display the status of the zoom setting, auto iris, and auto focus. This

information appears in the upper left corner of the monitor. The information only appears when
there is a change in the status of any item and remains on the screen for five seconds.

Procedure 6-6 Display or Hide the Camera Status

Step  Action

1 Select OSD from the Camera Configuration menu.

2 Select the Status tab.
The Status tab displays.

3 Select the Status check box to display the camera status in the OSD.
Or

Deselect the Status check box to hide the camera status in the OSD.
The default setting is ‘Disabled’.

- End -
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6-64

Displaying Dome Names

You can choose to display the area, preset, pattern and alarm names on the on screen display
when they are active.

Procedure 6-7 Display or Hide the Dome Names

Step  Action

Select OSD from the Camera Configuration menu.
2 Select the Dome Names tab.
The Dome Names tab displays.
3 Select the corresponding check box to display the function in the on screen display:
* Area Name
* Preset Name
* Pattern Name
* Alarm Name
Or
Deselect the corresponding check box to hide the function in the on screen display.

The default setting for all functions is ‘Disabled’.

-End -

Displaying Time/Direction Indicators

Display the time, and the approximate direction the dome is pointing in relation to its established
“North Position”.

Procedure 6-8 Display or Hide Time/Direction Indicators

Step  Action

Select OSD from the Camera Configuration menu.
2 Select the Time/Direction Indicators tab.
The Time/Direction Indicators tab displays.
3 Select the corresponding check box to display the function in the OSD:
* Time
* Direction Indicator
Or
Deselect the corresponding check box to hide the function in the OSD.
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The default setting for all functions is ‘Disabled’.

-End -

Configuring Text Attributes
Choose whether to display text as translucent (slightly clear) or solid. If on-screen text obscures

the video being displayed, enable translucent names. Character outlines and translucent names
may be used together to best suit your video environment.

Procedure 6-9 Configure Text Attributes

Step Actionda

Select OSD from the Camera Configuration menu.

2 Select the Text Attributes tab.
The Text Attributes tab displays.
3 Select the corresponding check box to enable the text attribute in the OSD:

» Translucent
Or
Deselect the corresponding check box to disable the text attribute in the OSD.

The default setting is ‘Disabled’.

- End -
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Video

The dome allows the configuration of two independent video streams, Stream 1 and Stream 2.
These streams can be configured via the Web GUI, as detailed here or via the lllustra API or

Network Video Recorder.

Web GUI Video

Video displayed on the live web video pane will use the settings configured in Stream 1.

Alarm Video

It is possible to use either Stream 1 or Stream 2 for the on-board recording of alarm video.

Integration with American Dynamics Network Video Recorders

Stream 1 and Stream 2 can be configured via the Web GUI, as detailed here or via the Network

Video Recorder interface. Changes made to the streams via either method will be applied and the

video will be displayed according to the configuration.

Opening the Web GUI live view while the Network Video Recorder is recording video will allow the

stream to be shared and will minimise the impact on camera resources.

Integration with other lllustra API Clients

Stream 1 and Stream 2 can be configured via the Web GUI, as detailed here or via the lllustra API

interface. Changes made to the streams via either method will be applied and the video will be

displayed according to the configuration.

Opening the Web GUI live video will allow the stream to be shared with the lllustra API and will

minimise the impact on camera resources.

MJPEG Usage Consideration

MJPEG has a higher bandwidth requirement than H264, the following provides a recommendation
for quality settings when using MJPEG:

» Maximum possible Quality setting: 100

* Recommended Maximum setting: 90

+ Recommended High Quality setting: 75
* Recommended Medium Quality setting: 55

For high resolution we recommend the following reduced limits:

Resolution FPS Recommended Maximum Quality
1920x1080 30 60
1920x1080 15 70
1920x1080 7 80
1600x900 30 65
1600x900 15 75
1600x900 7 85
1280x720 30 70

6-66
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Resolution FPS Recommended Maximum Quality
1280x720 15 80
1280x720 7 90

Configuring the Web Video Stream

Adjust the settings for video displayed on the live video pane and video used for alarms.

Procedure 6-10 Configure the Video Stream settings

Step  Action

1 Select Video from the Camera Configuration menu.
The Stream 1 tab displays.
Select either the Stream 1 or Stream 2 tab to configure the settings.

3 Select the required Codec by selecting the radio buttons:
» H264
* MJPEG
The default setting is ‘H264’.

4 Select the required Resolution from the drop-down menu:

* (1920x1080) - 1080p
* (1600x900) - HD+

* (1280x720) - 720p

* (1024x576) - PAL+

* (960x540) - qHD

* (800x450)

* (640x360)

* (480x270)

* (320x180)

* (160x90)
The default setting is /(1280x720) - 720p’.
5 Use the slider bar to select the Frame Rate (ips).
The default setting is 30.
6 If MUPEG has been selected, MUPEG Quality will be enabled. Use the slider bar to select

the MJPEG Quality.
The default setting is 50.
OR

7 If H264 has been selected, Rate Control will be enabled. Select the required Rate Control
by selecting the radio buttons:
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* VBR (Variable Bit Rate)
* CBR (Constant Bit Rate)
The default setting is ‘'VBR'.

a

OR

If VBR has been selected, VBR Quality will be enabled. Select the required VBR
Quality from the drop-down menu.

*Highest
*High
*Medium
Low

eLowest

The default setting is ‘High’.

If CBR has been selected, CBR Bit Rate will be enabled. Use the slider bar to select
the CBR Bit Rate.

The default setting is 1000.

- End -

Select the Alarm Video Stream

6-68

Select which video stream to use for alarm video.

Note

Alarms are only available on the lllustra 625 PTZ Feature Plus Model.

Procedure 6-11 Select the Alarm Video Stream

Step  Action
1 Select Video from the Camera Configuration menu.
2 Select the Alarm video tab.
The Alarm Video tab displays.
3 Select the required Alarm Stream by selecting the radio buttons:

e Stream 1

e Stream 2

The default setting is ‘Stream 2’.

To modify the settings for the video streams, Refer to Procedure 6-10 Configure the Video
Stream settings.

Configuration and User Guide



Camera Configuration Menu

The selected stream will be used for video generated from an alarm.

- End -
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Audio

Allows you to configure the audio input, output, upload audio and stored audio clips.

Note

Audio is only available on the lllustra 625 PTZ Feature Plus Model.

Configuring Audio Input

Configure the audio input settings.

Procedure 6-12 Configure Audio Input

Step  Action

1 Select Audio from the Camera Configuration menu.
The Audio Input tab displays.

2 Select the Input Enable check box to enable the audio input settings. Audio Input settings
will only be available if Input Enable is selected.

Or
Deselect the Input Enable check box to disable audio input settings.
The default setting is ‘Disabled’.
3 Select the Input Gain check box to enable input gain.
Or
Deselect the Input Gain check box to disable input gain.
The default setting is ‘Enabled’.
4 Use the slider bar to select the Input Volume.
Values range from 1 to 100.
The default setting is 71.

- End -

Configuring Audio Output

Configure audio output settings.

Procedure 6-13 Enable/Disable Audio Out

Step  Action
1 Select Audio from the Camera Configuration menu.
2 Select the Audio Out tab.

The Audio Out tab displays.
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3 Select the Output Enable check box to enable the audio output settings. Audio output
settings will only be available is audio output is selected.

Or
Deselect the Output Enable check box to disable audio input settings.
The default setting is ‘Disabled’.
4 If Output Enable has been enabled, use the slider bar to select the Output Volume.
Values range from 1 to 100.
The default setting is 80.

- End -

Configuring Stored Audio

When connected to an appropriate device, the dome is capable of playing back stored audio when
an alarm has been triggered. A maximum of three audio files can be uploaded to the dome.

Note

Audio clips can only be used if a microSD Card has been installed. Refer to the relevant Quick
Reference Guide for information on installing the microSD Card.

When uploading an audio file it must meet the following requirements:
* The filename cannot contain spaces.

* It must be a ‘wav’ file with a “.wav’ extension.

* A single channel mono file with a bit depth of 16kHz.

* The sample rate must be 8kHz.

* The duration must be no longer than 20 seconds.

Procedure 6-14 Play Stored Audio

Step  Action

Select Audio from the Camera Configuration menu.

2 Select the Stored Audio tab.
The Stored Audio tab displays.
3 Select to play back the corresponding audio file.

- End -

Uploading a Audio File

Upload an audio file to the dome.
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Procedure 6-15 Upload a Audio File

Step  Action

Select Audio from the Camera Configuration menu.
2 Select the Upload Audio tab.
The Upload Audio tab displays.
3 Select Browse.
The Choose file dialog will be displayed.
4 Navigate to the location where the audio file has been saved.
Select the audio file then select the Open button.
When uploading an audio file it must meet the following requirements:
*The filename cannot contain spaces.
+It must be a ‘wav’ file with a ‘.wav’ extension.
*A single channel mono file with a bit depth of 16kHz.
*The sample rate must be 8kHz.
*The duration must be no longer than 20 seconds.
Select Upload.
6 You will be prompted to confirm that you would like to upload the audio file.
Select OK to confirm the upload.
Or
Select Cancel.

- End -

Deleting a Stored Audio file

Remove a stored audio file from the dome.

Procedure 6-16 Delete Stored Audio

Step  Action

Select Audio from the Camera Configuration menu.

2 Select the Stored Audio tab.
The Stored Audio tab displays.

3 Select the corresponding Delete check box to mark the audio file for deletion.
Or
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Deselect the corresponding Delete check box to keep the audio file.

Note
Select the Select All check box to mark all audio files for deletion.

4 Select Delete to delete the selected audio files.
You will be prompted to confirm the deletion.

5 Select OK to confirm the deletion.
Or
Select Cancel.

- End -
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Home

6-74

The home position is a preset, pattern or scan/sequence that automatically runs after a designated
period of dome inactivity. Use this option if you want to keep a specific area under surveillance
when the dome is not moving.

Setting a Home Position

Use a home position on the dome.

Procedure 6-17 Configure the Home Position

Step  Action

1 Select Home from the Camera Configuration menu.
The Home Position tab displays.

2 Select the Home Position Type:

* Preset

» Pattern

* Sequence
» Scan

* None

If an action is selected chose the type of action to perform from the Parameter drop-down
menu.

Use the slider bar to select the Return Time (mins).
Select Apply to save the settings.

- End -

Removing the Home Position

Remove the current home position.

Procedure 6-18 Clear the Home Position

Step  Action

1 Select Home from the Camera Configuration menu.
The Home Position tab displays.
Select the None from Home Position Type.

3 Select Apply to save the settings.

- End -
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When the Networking menu is selected Figure 7-1 Networking Menu will be displayed.

Figure 7-1 Networking Menu

American Dynamics LOG OFF
From Tyco Security Products Live View  Setup View ”J ‘ 5 i_,J_J_—,

o

Enable DHCP

IPv4 Address. 192.168.185.203
Network Mask 2552552550
Date Time
Users Gateway
sMTP
FTP Primary DNS Server
Firewall
Maintensnce Secondary DNS Server

Advanced Settings

Apply

From Tyco Security Products

The Networking Menu provides access to the following dome settings and functions:
« TCP/IP

* Date & Time

+ User Accounts

+ SMTP

« FTP

¢ Firewall

* Maintenance
» Advanced Settings
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TCP/IP

Configure the IPv4 and IPv6 settings on the dome.

7-76

IPv4

Set IPv4 settings for the dome.

Procedure 7-1 Configure the IPv4 Settings

Step  Action

1 Select TCP/IP from the Networking menu.
The IPv4 tab displays.

2 Select the Enable DHCP check box to enable DHCP and disable manual settings entry.
Or
Deselect to disable DHCP and allow manual settings entry.
The default setting is ‘Enabled’.

3 If Enable DHCP has been disabled:
a Enter the IPv4 Address in the IPv4 Address text box in the form xxx.XXX.XXX.XXX.
b  Enter the Network Mask in the Network Mask text box Xxx.XXX.XXX.XXX.
¢ Enter the Gateway IP address in Gateway text box XXX.XXX.XXX.XXX.
d Enter the Primary DNS Server in the Primary DNS Server text box XXX.XXX.XXX.XXX.
e Enter the Secondary DNS Server in the Secondary DNS Server text box

XXX XXX XXX XXX.
4 Select Apply to save the settings.
- End -
IPv6

Enable IPv6 on the dome.

Procedure 7-2 Enable/Disable IPv6

Step  Action
Select TCP/IP from the Networking menu.
2 Select the IPv6 tab.
The IPv6 tab displays.
3 Select the IPv6 Enable check box to enable IPv6 on the dome.

Or

Deselect the IPv6 Enable check box to disable IPv6 on the dome.
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The default setting is ‘enabled’.
If IPv6 is enabled the Link Local and DHCP address will be displayed if available.

- End -
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Date Time

Set the date and time format.

Setting Date Time

Change the date and time settings on the dome.

Procedure 7-3 Configuring the Date and Time

Step

Action

Select Date Time from the Networking menu.
The Date Time tab displays.

Select the Time 24-hour check box to enable the 24-hour clock.
Or

Deselect the Time 24-hour check box to enable the 12-hour clock.
The default setting is ‘24-hour’.

Select the Date Display Format:

* DD/IMM/IYYYY

* MM/DD/YYYY

* YYYY/MM/DD
The default setting is “YYYY/MM/DD’.

Select the Time Zone.
The default setting is ‘Eastern Time (US & Canada)

Select the Set Time setting by selecting the radio buttons:

* Manually

* via NTP
The default setting is ‘Manually’.

If you select Manually in step 5:

a Select the Date (DD/MM/YYYY) using the drop-down menus.
b Select the Time (HH:MM:SS) using the drop-down menus.
If you select via NTP in step 5:

a Enterthe NTP Server Name in the text box.

Select Apply to save the settings.

- End -

7-78

Configuration and User Guide



Networking Menu

Users

In this section you are able to add and delete user accounts. There are three levels of access:
admin, operator and user.

Refer to Appendix A: User Account Access for details on the access rights of each account.

Add User

Add a new user account to allow access to the dome.

Procedure 7-4 Add a User

Step  Action

Select Users from the Networking menu.
Select the Add User tab.
The Add User tab displays.

3 Enter a User Name in the Name text box.

The username must start with a letter and can be followed by any alphanumeric values (a-
z, A-Z, 0-9) and the following special characters, underscore(_), dash(-), or dot(.)

4 Select a Role:

+ admin

* operator

> user

Refer to Appendix A: User Account Access for details on access areas for each role.
5 Enter a password in the Password text box.

The password must start with an alphanumeric character and is case sensitive, it can
contain alphanumeric characters with a length of between 4 and 32 characters.

Enter the same password in the Confirm Password text box.
Select Apply to save the settings.

- End -

Changing the User Accounts Password

Change the password of an existing user account.

Procedure 7-5 Change User Password

Step  Action
1 Select Users from the Networking menu.
2 Select the Change Password tab.
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The Change Password tab displays.

Select the user account from the Name drop-down menu.

Enter the current password for the user account in the Current Password text box.
Enter the new password for the user account in the New Password text box.

The password is case sensitive and can contain alphanumeric characters with a length of
between 4 and 32 characters.

6 Enter the same new password in the Confirm New Password text box.

Select Apply to save the settings.

- End -

Delete a User Account

Delete a user account from the dome.

Note

The default ‘admin’ account cannot be deleted.

Procedure 7-6 Delete a User Account

Step  Action

1 Select Users from the Networking menu.
The Users tab displays.
2 Select @ to delete the corresponding user account.
You will be prompted to confirm the deletion.
3 Select OK to delete.
Or
Select Cancel.

- End -
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SMTP

Configure the SMTP settings to allow e-mail alerts to be sent from the dome when an alarm is
triggered.

Configure SMTP

SMTP settings must be configured to enable email alerts when using alarms.

Procedure 7-7 Configure SMTP Settings

Step  Action
1 Select SMTP from the Networking menu.
The SMTP tab displays.
2 Enter the IP Address of the mail server in the Mail Server text box.

Enter the server port in the Server Port text box.
The default setting is 25.
4 Enter the from address in the From Address text box.
Enter the address to send email alerts to in the Send Email to text box.

Select the Use authentication to log on to server check box to allow authentication
details to be entered.

Or
Deselect the Use authentication to log on to server to disable authentication.
The default setting is ‘Disabled’.
7 If Use authentication to log on to server check box has been selected:
a Enter the username in the Username text box.
b Enter the password in the Password text box.
8 Select Apply to save the settings.

Note

Refer to Procedure 7-8 Test the SMTP Settings to confirm that the SMTP settings
are working as expected.

- End -

Test SMTP Settings
Test the SMTP settings that have been configured in Procedure 7-7 Configure SMTP Settings.
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Procedure 7-8 Test the SMTP Settings

Step  Action

1 Select SMTP from the Networking menu.
The SMTP tab displays.

2 Select Test.

A sample email will be sent to the specified email address to confirm that SMTP settings
are correct.

The dome will display a message confirming that the transfer was either successful or
failed.

- End -
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FTP

Configure the FTP settings for the FTP server.

Configuring FTP Server Settings

FTP must be configured to enable FTP alerts when using alarms.

Procedure 7-9 Configure FTP Server Settings

Step  Action

1 Select FTP from the Networking menu.
The FTP tab displays.
Enter the IP address of the FTP Server in the FTP Server text box.
Enter the FTP port in the FTP Port text box.
The default setting is 21.

4 Select the Use authentication to log on to server check box to allow authentication
details to be entered.

Or
Deselect the Use authentication to log on to server to disable authentication.
The default setting is ‘Disabled’.
5 If Use authentication to log on to server check box has been selected:
a Enter the username in the Username text box.
b Enter the password in the Password text box.

6 Select Apply to save the settings.

Note

Refer to Procedure 7-10 Test the FTP Settings to confirm that the FTP settings
are working as expected.

- End -

Test FTP Settings

Test the SMTP settings that have been configured in Procedure 7-9 Configure FTP Server
Settings.

Procedure 7-10 Test the FTP Settings

Step  Action

1 Select FTP from the Networking menu.
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The FTP tab displays.
2 Select Test.

A sample text file will be sent to the specified FTP destination to confirm that FTP settings
are correct.

- End -
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Firewall

Configure the Basic Filtering and Address Filtering for the Firewall.

Basic Filtering

Enable or disable basic filtering for the dome this includes, ICMP Blocking, RP Filtering, SYN
Cookie Verification.

Procedure 7-11 Enable/Disable Basic Filtering

Step  Action

1 Select Firewall from the Networking menu.
The Basic Filtering tab displays.

2 Select the ICMP Blocking check box to enable ICMP blocking.
Or
Deselect the ICMP Blocking check box to disable ICMP blocking.
The default setting is ‘Disabled’.

3 Select the RP Filtering check box to enable the RP filtering.
Or
Deselect the RP Filtering check box to disable.
The default setting is ‘Disabled’.

4 Select SYN Cookie Certification check box to enable SYN cookie certification.
Or
Deselect the SYN Cookie Certification check box to disable.

The default setting is ‘Disabled’.

- End -

Address Filtering

Set the address filtering for the dome.

Procedure 7-12 Enable/Disable and configure Address Filtering

Step  Action

Select Firewall from the Networking menu.

2 Select the Address Filtering tab.
The Address Filtering tab displays.

3 Select the Address Filtering check box to enable address filtering.
Or
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Deselect the Address Filtering check box to disable address filtering.
The default setting is ‘Disabled’.
4 If address filtering has been enabled:
a Enteran IP or MAC Address in the IP or MAC Address text box in the following
format Xxx.XXX.XXX.XXX.

Note

CIDR (Classless Inter-Domain Routing) is supported when using address filtering.
If using a CIDR address use the following format Xxx.XXX.XXX.XXX/XX.

b Select Add.
5 Select Apply to save the settings.

- End -

Editing an Address Filter

Edit an existing address filter.

Procedure 7-13 Edit an Address Filter

Step  Action

Select Firewall from the Networking menu.
Select the Address Filtering tab.

N

The Address Filtering tab displays.

Select I:I to edit the corresponding address filter.

Select Apply to save the changes to the address filter.

Edit the IP or MAC Address in the IP or MAC Address text box.
Select Add to save the changes.

Or

Select Cancel.

o 0~ W

- End -

Deleting an Address Filter

Delete an existing address filter.
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Procedure 7-14 Delete an Address Filter

Step  Action

Select Firewall from the Networking menu.

2 Select the Address Filtering tab.
The Address Filtering tab displays.

3 Select @ to delete the corresponding address filter.
Select Apply to confirm the deletion.

- End -
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Maintenance

7-88

Backup, restore, upgrade the firmware, perform a reboot or return to factory defaults from this
section.

Backup/Restore

Backup camera data and restore from a previously saved data file.

Save Camera Data

The configuration settings of the dome can be saved to a data file. The data file can be saved to a
specified location and used to restore the dome configuration.

Note

A saved backup data file created on a dome is camera specific and cannot be used to restore the
settings on another dome.

Procedure 7-15 Backup Camera Data

Step  Action

1 Select Maintenance from the Networking menu.
The Backup/Restore tab displays.

2 Select Backup.
You will be prompted to save the backup file.
Select a location to save the backup file.

Select Save.

- End -

Restore Camera Data

The dome has the ability to restore its configuration from a previously saved configuration file.

Note

A saved backup data file created on a dome is camera specific and cannot be used to restore the
settings on another dome.

Procedure 7-16 Restore Camera Data

Step  Action

1 Select Maintenance from the Networking menu.
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The backup/restore tab displays.
2 Select Browse.
The Choose file dialog will be displayed.
3 Navigate to the location where the backup file has been saved.
Select the backup file then select the Open button.
4 Select Upload.
You will be prompted to confirm that you would like to upload the backup file.
5 Select OK to confirm the upload.
Or
Select Cancel.

- End -

Upgrade Camera Firmware

The dome can be upgraded using firmware provided by American Dynamics.

Note
All existing camera settings are maintained when the firmware is upgraded.

ACaution

You should only use firmware that has been provided by American Dynamics. Using any other
firmware may cause a malfunction and damage the dome.

Procedure 7-17 Upgrade Camera Firmware

Step  Action

Select Maintenance from the Networking menu.

2 Select the Camera Upgrade tab.
The Camera Upgrade tab displays.
3 Select Browse.
The Choose file dialog will be displayed.
4 Navigate to the location where the firmware file has been saved.
Select the backup file then select the Open button.
5 Select Upload.
You will be prompted to confirm that you would like to upload the firmware file.
6 Select OK to confirm the upload.
Or
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Select Cancel.

When the dome is restarted it checks its functionality by performing a homing routine
during which the camera pans and then either goes to the start point of the ‘apple peel’
pattern or if powered up once before, to the last position in memory. Once the camera
stops, it is online and ready to be accessed and controlled.

- End -

Upload a HTTPS Certificate

The dome will automatically create an SSL certificate file to use for HTTPS. It is possible to upload

a custom SSL certificate if validation is desired.

Procedure 7-18 Add a HTTPS Certificate

Step

Action

Select Maintenance from the Networking menu.

Select the HTTPS Certificate tab.

The HTTPS Certificate tab displays.

Select Browse.

The Choose file dialog will be displayed.

Navigate to the location where the HTTPS certificate has been saved.

Select the backup file then select the Open button.

Note

Note the certificate needs to match the camera ‘host name’.

Select Upload.

You will be prompted to confirm that you would like to upload the HTTPS certificate.
Select OK to confirm the upload.

Or

Select Cancel.

- End -

Delete a HTTPS Certificate

If you delete the existing certificate it will be replaced by a temporary substitute. The current
browser session will be lost and you will be required to log back in to the dome.

7-90
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Procedure 7-19 Delete a HTTPS Certificate

Step  Action

Select Maintenance from the Networking menu.

2 Select the HTTPS Certificate tab.
The HTTPS Certificate tab displays.
3 Select Delete.

The camera will display a “Restarting HTTPS Service” page with a progress bar showing
the deletion progress.

When complete the camera will return to the log in page.

Refer to Procedure 3-1 Log in to the Dome.

- End -

Rebooting the Dome

Perform a reboot of the dome.

Procedure 7-20 Reboot the dome

Step  Action

Select Maintenance from the Networking menu.
2 Select the Reboot tab.

The Reboot tab displays.
3 Select Reboot.

You will be prompted to confirm the dome reboot.
4 Select OK to confirm.

Or

Select Cancel.

5 The camera will display a “Rebooting” page with a progress bar showing the reboot
progress.

When the dome is restarted it checks its functionality by performing a homing routine
during which the camera pans and then either goes to the start point of the ‘apple peel’
pattern or if powered up once before, to the last position in memory. Once the camera
stops, it is online and ready to be accessed and controlled.

- End -
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Reset the Dome to Factory Default Settings

Restore the settings on the dome to factory default.

Note

Network settings, presets, patterns and sequences can be retained if required.

Procedure 7-21 Resetting the dome

Step  Action

1 Select Maintenance from the Networking menu.

2 Select the Reset tab.
The Reset tab displays.

3 Select the Preserve networking settings check box to retain the current network settings
during the dome reset.
Or

Deselect the Preserve networking settings to restore the default networking settings.
The default setting is ‘Enabled’.

4 Select the Preserve presets, patterns and sequences check box to retain the current
presets, patterns and sequences during the dome reset.

Or

Deselect the Preserve presets, patterns and sequences to remove existing presets,
patterns and sequences.

The default setting is ‘Enabled’.
5 Select Reset

You will be prompted to confirm the dome reset.
6 Select OK to confirm.

Or

Select Cancel.

- End -
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Physical Reboot/Reset of the Dome

It is possible for perform a physical reboot or reset to factory defaults using the reset/reboot switch
located on the dome, refer to Figure 7-2 Reset/Reboot Switch on the Dome.

Note

To perform a physical reboot or reset, access is required to the dome itself. If the dome is being
used in an Outdoor Housing or with the Indoor Housing Assembly, refer to the quick start guides
supplied with the products for details on how to remove the bubble and gain access to the dome.

Figure 7-2 Reset/Reboot Switch on the Dome

Reset/Reboot Switch

Rebooting the Dome using the Reboot/Reset Switch

Perform a reboot of the dome using the reboot/reset switch.

Procedure 7-22 Reboot the dome using the Reboot/Reset Switch

Step  Action

1 Locate the reset/reboot switch on the dome.
Refer to Figure 7-2 Reset/Reboot Switch on the Dome.
Press and hold the reset/reboot switch for at least 10 seconds.
Release the reset switch.
It may take up to 10 seconds for dome to restart.
When the dome is restarted it checks its functionality by performing a homing routine
during which the camera pans and then either goes to the start point of the ‘apple peel’

pattern or if powered up once before, to the last position in memory. Once the camera
stops, it is online and ready to be accessed and controlled.

- End -
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Resetting the Dome to Factory Default Settings using the
Reset/Reboot Switch

The reset/reboot switch can be used to restore the dome to the factory default settings.

Note

It is not possible to retain network settings, presets, patterns or sequences when using this
procedure. If you need to maintain these settings it is recommended to reset the dome using the
GUI, refer to Procedure 7-21 Resetting the dome.

Procedure 7-23 Reset the Dome to Factory Default Settings using the
Reset/Reboot Switch

Step  Action

1 Locate the reset/reboot switch on the dome.
Refer to Figure 7-2 Reset/Reboot Switch on the Dome.
Press and hold the reset/reboot switch for 15 seconds or longer.
Release the reset switch.
It may take up to 10 seconds for dome to restart.
When the dome is restarted it checks its functionality by performing a homing routine
during which the camera pans and then either goes to the start point of the ‘apple peel

pattern or if powered up once before, to the last position in memory. Once the camera
stops, it is online and ready to be accessed and controlled.

- End -
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Advanced Settings

Configure the camera name, bandwidth throttling, session timeout and remote access on the
dome.

Camera Name

The camera name will be displayed on the GUI banner and the on-screen display for the dome.

Procedure 7-24 Edit the Camera Name

Step  Action

1 Select Advanced Settings from the Networking menu.
The Camera Name tab displays.
2 Enter the name of the camera in the Camera Friendly Name text box.

- End -

Session Timeout

Specifies the number of minutes that a web session can remain idle before it is automatically
terminated.

Procedure 7-25 Set a Session Timeout time

Step  Action
1 Select Advanced Settings from the Networking menu.
2 Select the Session Timeout tab.

The Session Timeout tab displays.
3 Use the slider bar to select the Session Timeout (mins).
The default setting is 60 minutes.

- End -
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Remote Access

SSH Enable
Enables Secure Shell access into the dome, if remote access is permitted by the camera network.

This will also enable American Dynamics Level 3 Technical Support to diagnose any problems on
the dome.

Note

It is recommended to keep SSH Enable disabled. This function should only be enabled this when it
is requested by American Dynamics Level 3 Technical Support.

Procedure 7-26 Configure SSH

Step  Action
1 Select Advanced Settings from the Networking menu.
2 Select the Remote Access tab.

The Remote Access tab displays.

3 Select the SSH Enable check box to enable SSH.
Or
Deselect SSH Enable check box to disable SSH.
The default setting is ‘Disabled’.

- End -

ONVIF

The Web GUI allows ONVIF functionality to be managed at a high level. ONVIF Discovery Mode
and User Authentication can be enabled or disabled.

* ONVIF Discovery Mode allows enabling or disabling discovery of the camera via ONVIF.

* ONVIF User Authentication allows the camera to accept ONVIF commands from all users or
only authenticated users. Enabling User Authentication ensures the camera will only execute
commands from authenticated users.

The separation of Discovery Mode and User Authentication allows the dome to be setup in a
configuration that suits requirements for the network and users. The preferred discovery method
for the dome is Illustra Connect, and this utilizes ONVIF discovery. It is therefore recommended
that ONVIF Discovery Mode is always enabled.

ONVIF Discovery Mode

Enable or disable ONVIF discovery on the dome.
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Procedure 7-27 Enable/Disable ONVIF Discovery Mode

Step  Action

Select Advanced Settings from the Networking menu.

2 Select the Remote Access tab.
The Remote Access tab displays.

3 Select the ONVIF Discovery Mode check box to enable ONVIF Discovery Mode.
Or
Deselect ONVIF Discovery Mode check box to disable ONVIF Discovery Mode.
The default setting is ‘Enabled’.

- End -
ONVIF User Authentication
Note
To utilize ONVIF User Authentication, there must be at least one admin level user in the ONVIF
service.

Procedure 7-28 Enable/Disable ONVIF User Authentication

Step  Action
1 Select Advanced Settings from the Networking menu.
2 Select the Remote Access tab.

The Remote Access tab displays.

3 Select the ONVIF User Authentication check box to enable ONVIF User Authentication.
Or
Deselect ONVIF User Authentication check box to disable ONVIF User Authentication.
The default setting is ‘Enabled’.

- End -

Dynamic DNS

Configure the Dynamic DNS settings for the camera.
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Procedure 7-29 Configure Dynamic DNS

Step  Action

Select Advanced Settings from the Networking menu.
2 Select the Dynamic DNS tab.
The Dynamic DNS tab displays.
3 Select the Service Enable check box to enable Dynamic DNS.
Or
Deselect Service Enable check box to disable Dynamic DNS.
The default setting is ‘Disabled’.
4 If Service Enable has been enabled:
a Enter the Camera Alias in the text box.
b Select a Service Provider from the drop-down list:
«dyndns.org
seasydns.com
*no-ip.com
ezerigo.com
edynsip.org
*tzo.com
¢ Entera Username in the text box.
d Enter a Password in the text box.
e Enter Service Data in the text box.

5 Select Apply to save the settings.

- End -
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When the Information menu is selected Figure 8-1 Information Menu will be displayed.

Figure 8-1 Information Menu

Help
American Dynamics LOG OFF

From Tyco Security Products Live View  Setup View _‘JJ u:,_x). Ierﬂ

’ <

Camera Name  i625ptz-ALPHA-0028

Model illustra 625 PTZ
Product Code  ADCi625-P132
Manufacturing Date  10-23-2012
Statistics Serial Number  ALPHA-0028
Environmenta] MAC Address  00-17-EB-D574-CC
Logs
Current Faults Firmware Version  1.0.0.A4326AAT58

Hardware Version 1.0

From Tyco Secunity Products

The Information Menu provides access to the following dome information:
* Model

« Statistics

* Environmental

* Logs

* Current Faults
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Model

Model Information

8-100

When Model is selected information will be displayed on the following:

+ Camera Name

* Model

* Product Code

* Manufacturing Date
 Serial Number

* MAC Address

* Firmware Version

« Hardware Version

Procedure 8-1 Display Model Information

Step  Action

1 Select Model from the Information menu.
The model tab displays.

- End -
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Statistics

General Information

When General Information is selected information will be displayed on the following:
* Operating Time (days-hrs:mins)

+ Uptime (days-hrs:mins)

» User Resets

» Power Resets

» Total ROM (MByte)

+ Total RAM (MByte)

* Free RAM (MByte)

Procedure 8-2 Display General Information

Step  Action

1 Select Statistics from the Information menu.
The general information tab displays.

- End -

PTZ Summary

When PTZ Summary is selected information will be displayed on the following:
* Pan Rights

* Pan Lefts

« Tilt Down

 Tilt Up

+ Zoom Out

e« Zoom In

Procedure 8-3 Display PTZ Summary Information

Step  Action

Select Statistics from the Information menu.
2 Select the PTZ Summary tab.
The PTZ Summary tab displays.

- End -
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Environmental

Environmental Information

When Environmental is selected information will be displayed on the following:
* Internal Temperature

* Blower

* Heater

* Firmware Version

Procedure 8-4 Display General Information

Step  Action

1 Select Environmental from the Information menu.

The Environmental tab displays.

- End -
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Logs

System Log

The system log gives the most recent messages from the unix /var/log/messages file. Information
will include the following:

* Messages about system behavior such as process startup/shutdown.
« Warnings about recoverable problems that processes encounter.

» Error messages where processes encounter problems they cannot fix; note that this does not
mean that the process will not continue to work, only that it encountered an issue it could do
nothing about.

Procedure 8-5 Display System Log

Step  Action

1 Select Logs from the Information menu.
The System Log tab displays.
2 Select Refresh to refresh the log for the most up-to-date information.

- End -

Procedure 8-6 System Log Filter

Step  Action

1 Select Logs from the Information menu.
The System Log tab displays.

2 Enter the number of lines of the log file you would like to view in the Lines text box.
Enter the word or phrase that you would like to search for in the Filter text box.

Select Refresh to refresh the log for the most up-to-date information.

- End -

Boot Log

The Boot log is a log of the Linux operating system boot processes and will only be useful to
American Dynamics support engineers who require additional information on the device.
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Procedure 8-7 Display Boot Log

Step  Action

Select Logs from the Information menu.
2 Select the Boot Log tab.
The Boot Log tab displays.
3 Select Refresh to refresh the log for the most up-to-date information.

- End -

Procedure 8-8 Boot Log Filter

Step  Action
1 Select Logs from the Information menu.
2 Select the Boot Log tab.

The Boot Log tab displays.

Enter the number of lines of the log file you would like to view in the Lines text box.
Enter the word or phrase that you would like to search for in the Filter text box.
Select Refresh to refresh the log for the most up-to-date information.

- End -
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Current Faults

Current Faults

When Current Faults is selected information will be displayed on the following:
* # - details the fault index.

» Fault - a description of the fault.

» Date created - the time and date when the fault occurred.

+ Component - internal software component that raised the fault either DIOM (Digital Input Output
Monitor) or ENVM (Environmental Monitor).

+ Severity - indicates how serious the fault is. The following are supported, in increasing order of
severity, Clear, Warning, Critical and Error.

« Detail - extra information that supplements the fault description.

« Delete -remove the fault from the fault table.

Fault Details

DIOM (Digital Input Output Monitor) Component

The following faults can be raised by the DIOM (Digital Input Output Monitor) component when
using the lllustra 625 PTZ Camera Feature Plus:

+ DigitalAlarmInForce

+ DigitalRaiselnputAlarm1
+ DigitalRaiselnputAlarm2
+ DigitalRaiselnputAlarm3
+ DigitalRaiselnputAlarm4

System Faults

The following system faults may be raised:

» DiskUsage(Warning) - this warning is raised when the disk utilisation rises above the threshold
value “threshold2” held in SYSM.conf. Once an alarm is generated and the disk utilization
decreases 1% below the threshold value, the fault is then automatically cleared. The default
threshold value is 80%.

* PowerSupplyAlarm(Error) - this fault is raised when one or more of the internal DC power
supplies voltage level is either too high or too low. Once an alarm is generated and the DC
power voltage goes back into the proper range, the fault is then automatically cleared.

ENVM (Environmental Monitor) Component

If an environmental card is used the following faults can be raised by the ENVM (Environmental
Monitor) component:

* BlowerConditionFaulty (Error) - the blower condition may be GOOD or FAIL. Since the
environmental card hardware contains two blowers, the reported condition is the worst for both
blowers. Therefore, if one blower fails, but the other works correctly, the condition will be
reported as “Fail”.
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TemperatureTooHigh (Warning) - this fault is raised when the internal temperature of the
enclosure is equal to or exceeds the value MAX_TEMPERATURE held in ENVM.conf. Once an
alarm is generated and the temperature drops to a level 1 degree below the
MAX_TEMPERATURE value the fault is then automatically cleared. This is to avoid transient
changes in temperature around the threshold.

TemperatureTooLow (Warning) - a fault is raised when the internal temperature of the
enclosure is equal to or is below the value MIN_TEMPERATURE held in ENVM.conf. Once an
alarm is generated and the temperature drops to a level 1 degree above the
MIN_TEMPERATURE value the fault is then automatically cleared. This is to avoid transient
changes in temperature around the threshold.

TemperatureOrHumiditySafeMode (Error) - the “Safe ON” and “Safe OFF” operational modes
indicate that the environmental card software detected a failure in the temperature or humidity
sensor and turned the blowers and heaters to the safe default state. The blower safe default
state is “Safe ON”. The heater safe default state is “Safe OFF”.

rocedure 8-9 Display Current Faults

Step  Action

1 Select Current Faults from the Information menu.
The current faults tab displays.
- End -
Procedure 8-10 Delete Current Faults
Step  Action
1 Select Current Faults from the Information menu.
The current faults tab displays.
2 Select the corresponding Delete check box to mark the fault for deletion.
Or
Deselect the corresponding Delete check box to keep the fault.
Note
Select the Select All check box to mark all faults displayed in the list for deletion.
3 Select Delete to delete the selected faults.
You will be prompted to confirm the deletion.
4 Select OK to confirm the deletion.

Or
Select Cancel.

- End -
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Viewing Alarm Output

Procedure 8-11 View Alarm Output

Step  Action

1 Select Current Faults from the Information menu.
The Current Faults tab displays.

2 Select the Alarm Output tab.
The Alarm Output tab displays.

- End -

Clearing an Alarm Output

Clear an alarm output from the dome if it has been triggered.

Procedure 8-12 Clear an Alarm Output

Step  Action

1 Select Current Faults from the Information menu.
The Current Faults tab displays.

2 Select the Alarm Output tab.
The Alarm Output tab displays.

3 Select Apply to clear active alarms.
The text displayed will update to ‘Output Not Active’.

- End -
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Technical Specifications

This section provides information on the technical, environmental and operating specifications for

the i625PTZ dome.

Basic Summary of Features

* Mega pixel HD 1080p Resolution 30fps, 20X Optical zoom

* Progressive scan with square pixels

» Camera set-up
» Automatic white balance (AWB) or adjustable Manual White Balance (MWB)
* AGC On/off and limit
* True day night (TDN) automatic or manual
* Image freeze selectable for moving to presets
+ Real Time Continuous Auto Focus
* Open Shutter (DSS) to extend low light performance
» Wide Dynamic Range Mode (WDR)
* Frame Noise Reduction (FNR)

Technical Specifications

Specification

Detail

Max Manual Pan Speed

0.25° to 100° per second scaled in proportion to zoom
position.

Preset Pan Speed

512° per Second Maximum.

Pan Travel

360° continuous, no end stop.

Manual Tilt Speed

0.25° to 100° per second scaled in proportion to zoom
position.

Preset Tilt Speed

512° per Second Maximum.

Tilt Travel

From viewing directly down to 105° above the horizon

Optical Zoom

20X

Tilt Pan Accuracy

+/-0.25°

Horizontal Field of View

55.2° (wide); 2.9° (telephoto)

Vertical Field of View

31.8° (wide); 1.8° (telephoto)

Aperture (Aspherical Design)

F1.6~F3.5 (wide~telephoto)
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Specification

Detail

Focal Length

4. 7mm~94mm (wide~telephoto)

Zoom and Pan Accuracy

+/-0.5°

Preset access Time

Less than 1 second to position.
Full zoom position in < 4 seconds.
Focus on saved presets is < 1 second.

Areas 16
Privacy Zones 32
Alarm Inputs 4

Auxiliary Output

One form 1-C relay

Language Selection

English (default), Arabic, Czech, Danish, German,
Spanish, French, Hungarian, ltalian, Korean, Japanese,
Netherlands, Polish, Portuguese, Swedish, Turkish,
Chinese Traditional, Chinese Simplified.

Program Storage

256MB of electrically programmable Flash Memory

Technical Details

Category

Details

Scanning System

Progressive

Sync System

Internal Sync

Image Sensor

1/3 type solid state Progressive Scan CMOS Sony IMX036LQR

Output Pixel Format

1920(H) x 1080(V) 2.07MP

Pixel Size

2.5 um square

Scanning Area

4.8 (H)mm x 2.7 (V) mm

Shutter Speed 1/30,000 to %2 second
Lens Design Aspherical
Optical Zoom 20 X, f=4.7mm, F1.6 (wide) to f=94mm, F3.5 (telephoto)

Minimum Focus Distance

«~1.0m (telephoto) ~ 30cm(wide angle)

Minimum Illlumination

0.4 Lux Color, AGC on, 1/8 s

0.04 Lux B&W, AGC on, 1/8 s
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Video Compression

Category Details

Codec Streams 2 any codec, resolution quality/bit rate settings

IP Video Streams 4 maximum including codec sharing duplicate
streams

Resolutions (1920 x 1080) 1080p
(1600 x 900) HD+
(1280 x 720) 720p
(1024 x 576) PAL+
(960 x 540) gHD
(800 x 450)
(
(
(
(

640 x 360) nHD
480 x 270)

320 x 180)

160 x 90)

MJPEG/JPEG Compressor Key Functionality

The JPEG codec supports the JPEG baseline DCT encoding process with the following additional
configuration option:

* Quality: 1-100
H.264 Compressor Key Functionality

The H.264 codec supports the JPEG baseline DCT encoding process with the following additional
configuration options:

Category Details
Profile High level 4.2
GOP Length 1-150
Rate Control CBR

VBR

Frame Skip With CBR
Bit Rate (CBR) Selectable 16 kbps to - 10Mbps
Quality (VBR) Highest, High, Medium, Low, Lowest.

Network

This section covers the technical aspects and operation of all the core network related

components.
Category Details
Base Protocol TCP/IP - RPC4614
Internet Layer Addressing IPv4 - RFC791; IPv6 - RFC2460
Transport Layer TCP - RFC973
UDP - RFC768
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Category Details
Data Transmission HTTP - RFC2616
FTP - RFC959
Network Address Configuration DHCP - RFC2131

Zeroconf - RFC3927
Static IP address

Network Name Resolution DNS - RFC5395
DDNS - RFC 2136
Time Synchronization NTP - RFC1305

IETF NTP Working Group
i minute poll rate

E-mail SMTP - RFC5321
Authenticated SMTP - RFC4954
Authentication and Security TLS - RFC5346
HTTPS (HTTP over TLS) - RFC2818
WS-Security
Discovery WS-discovery - ws-discovery.pdf
Streaming RTP - RFC3550

RTSP - RFC2326
Unicast Streaming
Multicast RFC 1112 level 1

External Interface Protocol SOAP - SOAP 1.2
ONVIF -2.0
WS-Addressing
WS-Eventing

Base Protocol and Underlying Layers

The dome is an IP camera compatible with TCP/IP protocol.

The dome supports both IPv4 and IPv6, running either in single stack mode or dual stack mode
(supporting both IP versions at the same time).

TCP is used for two way communication and UDP will be used for broadcasting protocols.
HTTP is used for the ONVIF protocol as transport mechanism for SOAP calls.

FTP can be used to push alarm buffer video clips to a specified remote FTP server. The dome
can use anonymous FTP or a specified username and password. There is no incoming FTP
service.

IP multicast RFC 1112 level 1 support for sending but not receiving multicast IP datagrams to a
group of interested receivers in single transmissions is supported for audio, video and metadata
stream types. The steams can be controlled using the two methods described below:

1

A client can request a multicast stream using RTSP. When the client requests a stream the
server will respond with a multicast address in the ‘c=’ field of the describe response (RFC
4566). The client will then respond with a Setup request with the Transport Type set to
multicast, the device shall stop sending packets for a multicast configuration when no
more RTSP sessions are using the same multicast configuration.

An RTP multicast UDP stream can be started by an ONVIF ‘StartMulticastStreaming’
request with a specified media profile. Streaming continues until ‘StopMulticastStreaming’
is called for the same profile

Multicast RTSP sessions support the same authentication methods as unicast RTSP sessions.
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Network Address Configuration

* DHCP (Dynamic Host Configuration Protocol) will be enabled by default on the camera.
During the boot process, the camera will attempt to acquire a network address via DHCP. The
DHCP client will be configured to do 3 attempts with a 20 second timeout.

+ Static IP can be used if the dome cannot be found on the network using DHCP. In this mode, the
a static IP address, subnet mask, default router and a primary and secondary DNS server can
be configured. This will be used by the dome when turned on. It is possible to assign a static
IPv4 address while still allowing the IPv6 addressing to be Link Local (automatically assigned).

* Dynamic DNS or DDNS Dynamic Domain Name System is supported for updating, in real
time a changing IP address on the Internet to provide a persistent domain name for a resource
that may change location on the network. RFC 2136 Dynamic Updates in the Domain Name
System. In this situation the dome talks only to the DHCP server and the DHCP server is
responsible for updating the DNS server. The dome sends its hostname to the DHCP server
when requesting a new lease and the DHCP server updates the DNS records accordingly. This
is suitable for an intranet style configuration where there is an internal DHCP and DNS service
and the user wants only to access their camera within their own network.

By default, when making a DHCP request the dome will transmit its hostname as part of the
DHCP request. This option is not user configurable. The cameras hostname matches the
configurable parameter “camera name” on the web GUI. Any DHCP request will contain the
cameras hostname for use of the DHCP server to forward to an appropriate DNS server.

Network Name Resolution

The dome uses DNS protocol to resolve network names. DNS server address will be acquired via
DHCP or manually set for static IP configuration. Camera configuration supports symbolic names
for all remote end-points (except DNS servers) but in this mode will depend on a working and
correctly configured remote DNS server.

Email

The dome can send email alerts via SMTP to one specified mailbox using a specified SMTP
server. Support is provided for basic authenticated SMTP using username and password for login
on the SMTP server.

Remote Shell Access

For security reason, remote shell access is limited exclusively to American Dynamics Level 3
Technical Support. This function is not available to the end-user.

It is recommended to keep SSH Enable disabled. This function should only be enabled this when it
is requested by American Dynamics Level 3 Technical Support.

Authentication and Security

* HTTPS (HTTP over TLS) is used for the Web GUI. HTTP connections to the dome IP will
automatically be redirected to the HTTPS login page.

+ The dome will automatically create a SSL certificate file to use for HTTPS. It is possible to
upload a custom SSL certificate if validation is desired.

* The ONVIF service uses WS-Security Username Token Digest.
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ONVIF Video and Control Interface

The primary video and control interface to the dome is the Open Network Video Interface Forum
global standard for the interface of network video products. This uses SOAP over HTTP. The dome
provides ONVIF for integration to internal and external systems.

Interface Technical Specifications

Category Details
Description Language WSDL
Web Services Specification DPWS
Web Services Tool Kit WS4D
Web Services Protocol SOAP
Message Format XML
Discovery WS-Discovery
Security WS-Security
Video Transport RTP/RTSP
Audio Transport RTP/RTSP
Event Handling (alarms) WS-Eventing
» WS-Base Notification
» WS-Topics
Service Connection WS-Addressing
Security Permissions WS-Policy (ken to think about)
Data Object Exchange Spec. WS-Transfer

ONVIF Functions Supported

The following ONVIF functions are supported on the dome:
Device Management
Return List of Capabilities
Network Management
* Discovery
* DHCP hostname
* DNS
* NTP

System Management
* Device information
» Backup
* Restore
» Get/set system date and time
» Set camera to factory defaults
* Get system logs

» Get support information
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* Reboot
» Get/set/remove scope (assigns ID data)
* Fault codes
Security
Configure Video and Audio
* Video Source
* Audio Source
» Snapshot JPEG
PTZ Functions
» Get PTZ Configurations
* Get PTZ Configuration Options
» Set PTZ Configuration
* Absolute Move
* Relative Move
+ Continuous Move
» Stop
* Get Status
» Set Preset

» Get Presets (returns: profile token, unique token name, and preset name for
presets currently defined and stored in the)

* Go to Preset

* Remove Preset

* Get Presets And Lens Settings
* Go to Home Position

« Set Home Position

Event Handling Basic Notification Interface

ONVIF Functions Not Supported

The following ONVIF functions are not supported on the dome:
 Audio output configuration
» Video compression standards other than H.264, and MJPEG.
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microSD Card

External access is provided for a microSD for video alarm storage and audio output pre-recorded
clips. The maximum size of microSD card that can be used with the dome is 32GB.

Refer to the Quick Reference Guide provided with the dome for information on how to remove and
install the microSD Card.

ACaution

If you wish to use the SD card then it must be present when the camera boots up. Refer to
MicroSD Card for details on mounting and unmounting a MicroSD card.

Environmental

The product is designed to meet the following environmental conditions:

Operating Temperature:

Indoor -10°C to 50°C (14°F to 122°F)
Outdoor -40°C to 50°C (-40°F to 122°F)
Humidity 0 to 95% non-condensing
Storage Temperature -20°C to 65°C (-4°F to 149°F)

Power
Power can be provided by PoE+ or by a 24 VAC power line

PoE+

The indoor dome uses power over Ethernet Plus and is compliant to POE IEEE 802.3at™ class 4,
with up to 100m (300 feet) of cable.

24 VAC Power

Local powering is possible for both indoor and outdoor models, with the capability to have both
sources connected at any time. The local powering option is always available, whatever the PoE
status. If both power sources are connected, the first power source connected will provide all
power until power goes away. The power source connected second will serve as backup power
and power the dome if the first source fails. When 24VAC is present, outdoor operation is possible
with extra hardware for outdoor domes, which will power fans and heaters.

Category Details
Input Voltage 22 to 30 VAC, Class 2 LPS
Line Frequency 50/60 Hz
Max Current Indoor 1.4 amps RMS
Max Current Outdoor 2.8 amps RMS
Power on in rush current 18 amps for 5msec
Allowable drop out 30ms
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Category

Details

Connector

Pluggable Euro-style pin 3.5 terminal block
connector

Design Tolerance

Input minimum:19 VAC RMS without dropout

Input Maximum:Voltage >35 VAC RMS may damage
equipment

Line Frequency:47-63 Hz

Allowable drop out:30 ms

Surge Protection

The following applies:

Category Details

Power Line TVS rated at 60V, 250A, 1.5 Joules, 8/20us impulse

IP Data lines isolation transformer coupled

Audio TVS rated at 5V, 300 watts, 8/20us impulse
Gas discharge tube impulse rated at ten 8/20 us 5kA Impulses

Alarm Input TVS rated at 3.3V, 500 watts, 8/20us impulse
Gas discharge tube impulse rated at ten 8/20 us 5kA Impulses
Optocoupled with 500V isolation

Auxiliary Output Dry contact relay with1, 500 volt galvanic isolation

Regulatory Compliance

The lllustra 625 PTZ Camera meets the following regulatory requirements:

Emissions

FCC: Part 15 Class A

CE: EN55022 Class A
AS/NZS CISPR 22 Class A
ICES-003/NMB-003 Class A

Immunity

CE: EN50130-4
CE: EN55024
CE: EN61000-6-1

Safety

UL60950-1

IEC 60950-1

CSA 22.2 No. 60950

CE: EN60950-1

Outdoor: UL 50 (Type 4)
Outdoor: EN60529 (IP66)

Environmental

RoHS
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Appendix A: User Account Access

A

Camera Menu Tab Function Admin Operator User
View
Picture Settings White Balance X X -
Picture Balance X X -
Focus/Iris X X -
WDR X X -
IR/DayNight X X -
Shutter Limit X X -
Picture Settings X X -
Presets Presets List X X X
View X X X
Edit X X -
Delete X X -
Patterns Patterns List X X X
View X X X
Edit X X -
Delete X X -
Record X X -
Repeat X X -
Privacy Zones Privacy Zones List X X X
Enable/ X X -
Disable
View X X -
Delete X X -
Add Zone X X -
Scans Scans List X X X
View X X X
Scan Limits Set X X -
Sequences Sequences List X X X
View X X X
Edit X X -
Delete X X -
Alarms Alarms Summary List X - -
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Camera Menu Tab Function Admin Operator User
Edit X - -
1 List X - -
Edit X - -
2 List X - -
Edit X - -
3 List X - -
Edit X - -
4 List X - -
Edit X - -
Scheduled Tasks Scheduled Tasks List X - -
Edit X - -
Delete X - -
Add Task X - -
Area Areas List X - -
Edit X - -
Delete X - -
Camera Configuration
PTZ Flip X X -
Freeze Frame X X -
Return Settings X X -
Set North X X -
OSD Name X - -
Status X - -
Dome Names X - -
Time/Direction X - -
Indicators
Text Attributes X - -
Video Stream 1 X X -
Stream 2 X X -
Alarm Video X - -
Audio Audio Input List X - -
Edit X - -
Audio Output List X - -
Edit X - -
Stored Audio List X X X
Play X X X
Delete X X -
Upload Audio X X -
Home Home Position List X X -
Edit X X -
Networking
TCP/IP IPv4 List X - -
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Camera Menu Tab Function Admin Operator User

Edit X - -
IPv6 List X - -
Edit X - -
Date Time Date Time List X - -
Edit X - -
Users Users List X - -
Delete X - -
Add User X - -
Change Password X X* X*
SMTP SMTP List X - -
Edit X - -
Test X - -
FTP FTP List X - -
Edit X - -
Test X - -
Firewall Basic Filtering List X - -
Edit X - -
Address Filtering List X - -
Edit X - -
Maintenance Backup/Restore X - -
Camera Upgrade X - -
HTTPS Certificate X - -
Reboot Reset X - -
Advanced Settings Camera Name X - -
Bandwidth Throttling X - -
Session Timeout X - -
Remote Access X - -
Dynamic DNS X - -

Information
Model Model X X X
Statistics General Information X X -
PTZ Summary X X -
Environmental Environmental X X -
Logs System Log X - -
Boot Log X - -
Current Faults Current Faults List X X -
Delete X X -
Alarm Output X X -

* Admin users are able to change passwords for any user but Operator and User accounts can only change their own

password.
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Appendix B: Site Maps

Overview of the Web GUI

Login
Y
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Scheduled . ,
Patterns Tasks Video Users Environmental
Privacy Areas Audio SMTP Logs
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Scans Home FTP Current
Faults
Firewall
Maintenance
Advanced
Settings
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View Menu
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Camera Configuration
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Networking
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Appendix C: Using VLC Player to View RTSP
Streaming

Note

This appendix is provided for user instruction only. American Dynamics will not support or be
responsible for any error caused during the use of VLC software.

Viewing RTSP Stream via VLC Player

You can use VLC Player to view live video and audio in real time from the dome.

Procedure 12-1 View RTSP Streaming via VLC Player

Step  Action

1 It will be necessary to install the latest version of VLC Player from the website.
Visit www.videolan.org/vic/.

Select Download VLC. Run the installer and follow the directions on screen to install the
software.

2 Launch VLC Player.
Select Media then Open Network Stream. The Open Media window will display.

Enter the IP address of the dome stream in the Network URL text box in the following
format:

rtsp://<ip
address>/Video?Codec=<codec>&Width=<width>&Height=<height>&Fps=<frames per
second>

For example:
rtsp://192.168.1.168/Video?Codec=H264&Width=1920&Height=1080&Fps=30

Refer to the Configuration Options for RTSP Video Streams for examples on how to
configure the RTSP Video Stream.

5 Select Play.
The live video stream will be displayed.

- End -
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Retrieving the RTSP Address from the Dome

12-130

Use this procedure if you are unsure which codec settings are being utilized by the dome.

Procedure 12-2 Retrieve RTSP Address from the Dome

Step  Action

Open Microsoft Internet Explorer.

2 Enter the following address in the address bar to retrieve the specific risp address for
either Stream 1 or Stream 2:

« Stream 1: http://<IP Address>/iAPl/element.cgi?action=read&group=Stream.1
« Stream 2: http://<IP Address>/iAPl/element.cgi?action=read&group=Stream.2
3 The following Figure 12-1 RTSP Settings is a sample of text which will be displayed.

Figure 12-1 RTSP Settings

Stream.l.Codec=MJPEG
Stream.l.Enabled=1
Stream.l.FramsRate=30
Stream.l.H264.CERBitrate=1000
Stream.l.H264.CVBRMaxBitrate=10000
Stream.l1l.H264.G0PF=30
Stream.l.H264.Quality=Medium
Stream.l.H2&64.Ratecontrol=VEBR
Stream.l.ImageSourceld=1
Stream.l.MJPEG.Qualicy=T70
Stream.l.Metadata.Enabled=0
Stream.l.Metadata.S5treamld=1
Stream.l.Resolution=1520x1080
Stream.l.Transport=UDP
SCIeam.l.URLﬂItsp:fﬁlQ2.lGB.l.242:554(Video?CGdec=HJPEG&Width=l920&Height=lOBO&Qual=70&Fp5=30I

4 Copy the Stream.1 or Stream.2 rtsp address which has been highlighted in Figure 12-1
RTSP Settings.

Follow step 1 to 3 of Procedure 12-1 View RTSP Streaming via VLC Player
Paste the rtsp address in the Network URL text box.
7 Select Play.

The live video stream will be displayed.

- End -
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Configuration Options for RTSP Video Streams

The following provides examples on how to configure the RTSP Video Stream:
Video using a MJPEG codec
* rtsp://<ip address>/Video?Codec=MJPEG

Video at 640x360 using a MJPEG codec @30 FPS with No Audio
* rtsp://<ip address>/Video?Codec=MJPEG&Width=640&Height=360&Fps=30

Video at 1280x720 using a MJPEG codec @30 FPS with a CBR bitrate of 4Mbps and No
Audio

* rtsp://<ip
address>/Video?Codec=MJPEG&Width=1280&Height=720&Fps=30&RateControl=CVBRBitrat
e=4000000

Video at 800x450 using a H264 codec @ 15 FPS and No Audio
* rtsp://<ip address>/Video?Codec=H264&Width=800&Height=450&Fps=15

Video at 1280x720 using a H264 codec @ 30 FPS with a bitrate of 6Mbps and No Audio
* rtsp://<ip address>/Video?Codec=H264&Width=1280&Height=720&F ps=30&Bitrate=6000000

Video at 1280x720 using a MJPEG codec @ 30 FPS with a Quality of 75 and No Audio
* rtsp://<ip address>/Video?Codec=MJPEG&Width=1280&Height=720&Fps=30&Qual=75
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